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Welcome to CraftArtist 2 Professional—the digital crafting solution that 
combines crafting fun with a wealth of powerful drawing and crafting tools for 
the very best results. In an instant, you'll be able to create beautiful print projects 
with that professional touch! 

Projects such as greeting cards, scrap pages, photobooks, stationery, gift wrap, 
and party crafts can be created from ready-to-go layouts or from scratch—it's 
your choice! 

 

For unlimited design possibilities, CraftArtist works with a range of DaisyTrail 
Digikits, each offering themed items that you can use as starting points for your 
projects. Each Digikit includes a selection of drag-and-drop layouts, 
backgrounds, embellishments, materials, photo frames, brushes, colour 
swatches, and decorative letters. If you're feeling really creative, you can even 
create and save your own Digikits! 
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In addition to supplying ready-to-go content, CraftArtist lets you add decorative 
lines, shapes, and stencils. You can also apply natural or spray brush strokes 
using easy-to-use drawing and painting tools. Photos can be added to your 
project, and image adjustments and effects applied using the powerful 
PhotoLab. You can even cut out the subject of a photo, and create your own 
photo frames! 

Once you've created your masterpiece, you'll want to share it. A lively web-based 
craft designing community—DaisyTrail.com—is available for you to share your 
projects freely or to selected groups. You'll make some new friends along the way 
too! 

Don't forget to visit DaisyTrail.com to download your free Digikits—and 
purchase new ones! 

New features 

Crafting toolbox 

 

Create stunning decoupage effects (p. 62) 
Use the new Decoupage Tool for beautiful 
layered effects—great for enhancing your photos 
or embellishments alike! Have full control of your 
decoupage's appearance with control over number 
of decoupage layers, shape, shadow, and rotation. 

 

Punches (p. 73) 
The Punches tab lets you easily punch shaped 
holes out of items such as embellishments, 
materials, or photos. A single item, specific layer, 
or all layers can be punched through. 

http://www.daisytrail.com/�
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Stamping designs (p. 77) 
Replicate embellishments by stamping directly on 
the page—great for "floating" hearts, butterflies, 
footsteps, and more. Choose a "stamps" style for 
first, second, and third impressions. 

 

Import PDF files 
Unlock the contents of third-party craft designs 
(in PDF format) by opening directly from the 
Startup Wizard's Open section. 

 

Ready-to-use graphic styles! (see p. 161) 
The Styles tab lets you choose from various preset 
shadows, glows, bevels, feather edges, textures, 
text effects, and more. A graphic style, when 
applied, complements an item's existing graphic 
styles. For custom design, save your own graphic 
styles with control over which item properties 
(and attributes) are stored! 

 

Generate Palette from photos or Digikit items 
Create your page design using palette colours 
derived from your photo/Digikit item. The 
generated colour palette is added to the Colour 
tab's Digikit palette. 

 

Enhanced Colour Picker (see p. 199) 
Sample colours directly under the cursor or, for 
artefacted, halftone or dithered images, by 
averaging colours under a shaped region. Don't 
forget to try colour gradient sampling, for 
sampling sunsets, metal or glass surfaces, and 
more. 
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Performance 

• 64-bit operation 
CraftArtist 2 Professional is fully optimized for operation on 64-bit 
computers, and will automatically install for 64-bit operation 
accordingly. 

• Accelerated Graphics Technology 
More complex designs are drawn quicker and more accurately with 
CraftArtist's tiled, multi-threaded drawing engine. 

Ease of Use 

• Digikit Creator tagging improvements (see p. 39) 
Tagging becomes easier with simple copy (and paste) of tags via 
thumbnail right-click. 

• Customized menus and toolbars 
Tailor CraftArtist to your needs with menu, toolbar, and icon 
customization. 

• Tailor your keyboard shortcuts 
Take advantage of customizable keyboard shortcuts for enhanced 
productivity—assign your own keystrokes to toolbar and menu 
commands! Use single-key keyboard shortcuts for easy tool access. 

• Dynamic reordering of items 
Drag the Arrange tab's Depth slider to dynamically change the 
selected item's order in the current layer. 

• Enhanced Solo Mode 
For progressively detailed design work, use multi-level Solo Mode! 
You'll be able to focus on chosen areas in isolation, using a select-then-
solo approach—previous view levels can be returned to if needed. 
Operations are restricted to the current solo level, with the Layers tab 
only showing the items currently in view! 

• View Quality 
Operate in either Normal or Wireframe drawing modes; Wireframe 
mode displays vector items as single pixel outlines. 
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Text 

• On-the-page Font Preview (see p. 134) 
Choosing a different font or font size automatically previews on your 
selected text. 

• Professional-level OpenType Font Features 
For embellished text, CraftArtist fully utilizes all your OpenType font 
features—ligatures, stylistic sets/alternates, small/petite caps, case-
sensitive forms, fractions, ordinals are available. 

Printing and Sharing 

• Interactive Print Preview with print-time imposition (see p. 214) 
Try out the exciting new Print Preview, packed with both preview and 
imposition options—create greeting cards, photobooks, thumbnails, 
and tiled print output all without prior page setup. 

• Easier than ever Printing! (see p. 216) 
Try CraftArtist's Print dialog for the options you need, when you need 
them! With a focus on everyday printing options, including 
percentage scaling of your print output, the printing process becomes 
more intuitive and logical. Print-time layout imposition, saved print 
profiles, and manual duplex printing are other print features. 

• Pre-press PDF export (see p. 219) 
For professional-level printing, take advantage of PDF/X-1a 
compatibility, preset/custom PDF profiles, page marks, image 
compression, and more. Secure your PDF output with a password (to 
view and control PDF content manipulation).  
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Installation 

System requirements 

Minimum: 

• Windows-based PC with DVD drive and mouse (main processor must 
support SSE2 instructions) 

• Operating systems: 
Microsoft Windows® XP (32 bit) 
Windows® Vista (32 or 64 bit) 
Windows® 7 (32 or 64 bit) 
Windows® 8 (32 or 64 bit) 

• 512MB RAM (1GB RAM for 64-bit operation) 

• 1.1GB (recommended full install) free hard disk space (program only)* 

• 1024 x 768 monitor resolution 

* Does not include space requirements for downloaded Digikits. 

Additional disk resources and memory are required when editing large or 
complex documents. 

Optional: 

• Windows-compatible printer 

• TWAIN-compatible scanner and/or digital camera 

• Pen (graphics) tablet 

• Cutting machine 

• Internet account and connection required for accessing downloadable 
DaisyTrail.com Digikits, online resources, and project upload. 
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Installation procedure 

• Insert your purchased disc into your DVD drive. 

• If AutoPlay is enabled on the drive, this automatically starts the 
Setup Wizard. Follow the on-screen instructions for install. 
 
-or- 

• If AutoPlay is not enabled (or doesn't start the install 
automatically), navigate to your program disc and double-click 
autorun.exe. 

 32 or 64-bit CraftArtist 2 Professional installs to respective 32 or 64-
bit computers. 
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Start CraftArtist 
Once you have installed CraftArtist, you're ready to start crafting! By default, a 
CraftArtist 2 item is added to the All Programs submenu of the Windows Start 
menu. 

When you launch CraftArtist, a Startup Wizard appears. 

 

For this Quick Start book, we'll concentrate on the Choose a Template and 
Blank Project options. Along the way, you'll be able to add craft items to your 
template or blank project. 

Choose a template 
Digikits offer a selection of template layouts, backgrounds, frames, materials, 
letters, embellishments, brushes, swatches, and effects. 

If you want to get started quickly, selecting a template will help you to create 
your first project in just a few easy steps. 

You can also create original projects from scratch. See Start a blank project on 
p. 16. 
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Choosing a template 

1. From the Startup Wizard, click Choose a Template.  

2. From the dialog's Craft Projects tab, select the type of project you 
want to create, e.g. Greeting Cards, Scrap Pages, Photobooks, etc. 
 

 

3. In the middle pane, scroll to review each layout; on hover over, each 
layout's thumbnail gives a visual indication of your printed project. 
You'll see the same set of layouts repeated for each installed Digikit in 
turn. 
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4. Click to select the layout. 
 

 

5. Click OK to exit the dialog. The first page of the layout opens in the 
workspace, and all of the design items contained in the Digikit are 
added to the Content tabs at the left of the workspace. 
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6. Running horizontally along the lower edge of the workspace, the 
Pages tab displays the pages you chose to add to your project. 
 
Click through the thumbnails to view these pages in the workspace 
and choose the page you want to work on first. 
 

  

For fixed layouts such has greeting cards (above), your pages are added 
automatically. For other projects, you can insert, copy, move, and delete pages 
without constraint. 

 Additional Digikits are available from the DaisyTrail.com website. 

Start a blank project 

Creating a new blank project 

• From the Startup Wizard, click Blank Project.  

Choosing page size and layout 

When starting a blank project, you'll be able to set up your page size and layout 
initially, using standard or custom page sizes. 

http://www.daisytrail.com/�
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Using standard page sizes 

1. From the Page Setup dialog, select your project type from the left-
hand pane, e.g. Scrap Pages. 
 

 

2. From the middle pane, navigate the categories and click on your 
chosen page layout. 
 

 

3. Click OK. The Digikit Browser is displayed for adding Digikit content 
to your project. 
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Choosing Digikit content 

Digikit items such has Embellishments, Backgrounds, Frames, Materials, Letters, 
Layouts, Brushes, and Swatches can be included in your project immediately 
after setting up your page size and layout.  

1. In the Digikit Browser, select the Digikit from which you want to add 
items. (You can add items from more than one Digikit.) For example, 
for the Daydream Digikit. 

 In the Digikit Browser, you'll see any installed Digikits, plus a 
selection of free and purchasable Digikits from DaisyTrail.com. (See 
Buying and downloading Digikits on p. 33.) 

2. Scroll the main pane and select items from the Digikit's item 
categories. 

3. Click an item to add it to your craft project, or click Add all items  
to add them all. 

 If you select an item from a featured free or purchasable Digikit—
the Digikit Not Installed dialog will display. You can then click Visit 
Shop to download your Digikit from the DaisyTrail.com shop. Once 
you've installed your free or purchased Digikit, the item will be 
added to the relevant Content tab on selection. (See Buying and 
downloading Digikits on p. 33.) 

4. Optional: Click  Back to all Digikits to add items from other 
Digikits. 

5. When you've finished selecting items, click Done. 

In the workspace, the items you added are displayed in the relevant Content tab.  

http://www.daisytrail.com/�
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Adding photo frames 
1. In the Content tabs at the left of the workspace, open the Frames tab.  

2. Scroll the tab to find the item you want to add, and then drag it onto 
your page. 

3. Optional: Rotate your frame, using the rotation handle, for a more 
aesthetic effect. 

 To create custom photo frames, see Creating your own photo frames 
in CraftArtist Help. 

Adding your own photos 
1. On the Photos tab, click Add. 

2. In the Open dialog, browse to and select the photos you want to add to 
your project. 

• To select multiple adjacent files, press and hold down the Shift 
key, click the first file in the list, and then click the last file. 

• To select multiple non-adjacent files, press and hold down the 
Ctrl key, and then click to select. 

3. Click Open. Your photos are added to the Photos tab. 

4. To add a photo to your page, simply drag it from the Photos tab. You 
can drag directly onto the page, or onto an existing photo frame. 
 

 

5. Optional: You can adjust your photo inside its frame, or even replace 
it if required. 
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Adjusting and replacing framed photos 

1. Select the framed photo, and then click the Crop button. 
 

  

2. To rotate, or zoom into or out of the photo, click the buttons displayed 
at the right edge of the photo. 
 

  

3. To zoom and pan the photo, click  and then drag the photo, 
respectively. 
 

  

4. To close the Crop window, click  Back, or click elsewhere on the 
page or pasteboard area. 
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To replace a photo: 

• Drag a different photo onto a frame from the Photos tab. 
 
-or- 

1. Select the framed photo you want to replace, then click the  Select 
Cropped Item(s) button that displays below it. 

2. Click the  Replace Photo button on the Photo context toolbar. 

3. Browse to and select the photo you want to add and click Open. 

Adding decorative items 
1. In the Content tabs at the left of the workspace, open the 

Embellishments or the Materials tab.  

2. Scroll the tab to find the item you want to add, and then drag it onto 
your page. 
 

 

 To create your own custom designs of this type, see Creating your 
own Digikits on p. 36. 
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Changing your background 
1. In the Content tabs at the left of the workspace, open the Backgrounds 

tab.  

2. Scroll the tab to find the item you want to add, and then drag it onto 
your existing background. 
 

 

 To create your own custom designs of this type, see Creating your 
own Digikits on p. 36. 
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Adding letters 
1. Open the Letters tab.  

2. To add an individual letter or number, drag it from the tab onto your 
page. 
 

 
-or- 
 
To add an entire word or phrase all at once, type it into the text box at 
the bottom of the tab and click Insert. The word is added directly onto 
the page. 
 

 
 

 

Individual letters can be selected, sized, and positioned independently after 
deselection.  

Alternatively, click  Group to keep letters grouped together. 
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 For precise alignment of letters you can switch on ruler guides then 
snap your letters into position. Alternatively, use the Align tab for 
multi-letter alignment. 

Sharing via DaisyTrail.com 

1. Click  Share on the Standard toolbar. 

2. If you've registered (see p. 211) and are uploading for the first time, 
enter the Username and Password you created on DaisyTrail.com. 
You won't need to do this again on subsequent uploads. 
 
The DaisyTrail Upload dialog appears. 
 

 

3. Optional: In the dialog, uncheck pages you don't want to upload (use 
the scroll bar to view all pages). 

4. Click Upload to transfer your selected pages. 

5. On upload, a progress bar indicates upload status. 
 
On completion, click OK to close the dialog or click View to 
immediately see your uploaded project on the website. 

http://www.daisytrail.com/�
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Make & Do projects 
Make & Do projects are a great excuse to get the scissors and glue out and try 
your hand at a physical project. These are typically cards for occasions or simply 
based on a theme. 

To make your project easy to complete, CraftArtist suggests equipment and 
materials needed. You'll also be able to follow a step-by-step video along with 
written How To instructions. 

 

Each Make & Do project is actually a *.craft file, containing all the instructions, 
examples, and embellishments you'll need. The embellishments can be printed 
and cut out to complete your project. 
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 Starting a Make & Do Project 

1. Launch CraftArtist, or click File>New>New from Startup Wizard 

2. In the Startup Wizard, click Make & Do Project. 

 If you've switched the Startup Wizard off, you can switch it on again. 
Click Tools>Options, select the User Inteface>Ease of Use option, 
and then select the Startup Wizard check box. 

3. From the dialog, choose a level which you feel most comfortable 
with—Beginner, Intermediate, or Advanced. Different Craft Projects 
will be offered for each level. 

4. Select the project you want to make, then click OK. 

5. From the Pages tab, make your project by following the Start Page 
then Instructions page. Subsequent Print Template pages let you edit, 
print, and cutout embellishments for your project. 

 It's a great idea to undock your video (by double-clicking) so it is 
viewable from every page. 
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Browsing 
The Digikit Browser provides access to your installed Digikits, and to a 
selection of featured free and purchasable Digikits from DaisyTrail.com, 
including designer-made Digikits. You can browse Digikits and preview the 
items they contain, before adding them to your workspace. 

There are two ways to browse Digikit items—by Digikit, or by item category. 

You can also use the search controls at the right of the dialog to search all 
Digikits, or to find a specific item.  

Browsing Digikits 

1. On the Pages context toolbar, click  Add items from Digikits. 

2. In the Digikit Browser, you'll see installed Digikits, plus free or 
purchasable Digikits from the DaisyTrail.com shop. (See Buying and 
downloading Digikits on p. 33.)  
 
Browse the Digikits in My Digikits, Latest Free kits from 
DaisyTrail.com and DaisyTrail categories—some featured designer's 
Digikits are also available. Hover over your chosen Digikit to see a 
zoomed-in preview for further inspection, then click its thumbnail. 
 
For more Digikits online, click More at DaisyTrail.com>. See Buying 
and downloading Digikits on p. 33. 

3. Scroll through the categories to browse items included in the Digikit. 

4. Optional: To narrow your search, filter items by clicking tag names 
(e.g., Flower) in the Categories section. (See Applying a search filter on 
p. 30.) 

5. To browse another Digikit, click  Back to 'All Digikits'. 
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Browsing items 

1. In the Digikit Browser dialog, click the Browse my items tab. You'll 
see items belonging to installed Digikits, plus featured free and 
purchasable Digikits from the DaisyTrail.com shop. (See Buying and 
downloading Digikits on p. 33.) 

2. On the left-hand side of the dialog, select an item category you want to 
browse, e.g., Embellishments. 

3. The items are categorized further in the middle pane by the name of 
the Digikit to which they belong, e.g., Daydream. Scroll through to 
browse the items included in each Digikit. To make browsing easier, 
you can expand and collapse the Digikit categories to hide or reveal 
the items. 

4. Optional: To narrow your search, filter items by clicking tag names 
(e.g., Flower) in the Categories section. 

Applying a search filter 

The filter searches preset and custom tags applied to all of the Digikits shown in 
the Digikit Browser (this includes Digikits you have installed, and Digikits 
available from the DaisyTrail.com shop). (See Tagging on p. 39.) 

1. Click  Add items from Digikits. 

2. Click Browse Digikits or Browse my items, depending on which 
browsing method you prefer. 

http://www.daisytrail.com/�
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3. There are two methods by which you can apply search filters, and both 
can be used together to further narrow your search. 

• Select a preset search tag from the drop-down menus. 
 

 

• Type the word or letter you want to search for in the Search text 
box, situated at the right of the dialog. This is useful for retrieving 
items with custom tags attached. 
 

 

 

 Ctrl-click to select more than one filter. Click  to remove the 
filter(s). 

If you've searched via the Browse Digikits tab, the Digikit containing the 
relevant items is displayed for you to select and browse further. 
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If you've searched via the Browse my items tab, click on each category, e.g., 
Backgrounds, to reveal the relevant items. 

 

Adding items to your workspace 

• To add items to your workspace via the Browse Digikits tab, select the 
Digikit you want to browse and then simply click the item you want to 
add. 

• To add items to your workspace via the Browse my items tab, select 
the category you want to browse, and then simply click the item. 

•  To add all items from a selected Digikit, select the Digikit, and 
then click the Add Digikit button that displays in the lower-left corner 
of the dialog. 

• To add all items in a category, click the Add all items  button that 
displays in the upper-right corner of each category's thumbnail gallery. 

 If you select an item, or add all items, from a featured free or 
purchasable Digikit—the Digikit Not Installed dialog will display 
and you will be prompted to visit the DaisyTrail.com shop. Once 
you've installed your free or purchased Digikit, the item will be 
added to the relevant Content tab on selection. (See Buying and 
downloading Digikits on p. 33.) 



Digikits 33 

 

•  To remove a specific item from your workspace, select the 
"checked" item in the Digikit Browser or, in the relevant Content tab, 
click Remove under the item thumbnail. 

•  To remove a selected category's items or all items from your 
workspace, click the respective Clear <Category name> or Clear All 
Categories button that displays in the lower-left corner of the dialog. 

Saving Digikits 

If you've populated your Content tabs with a range of items, you have the option 
of saving these items to your own custom Digikit using the Digikit Creator (see 
Creating your own Digikits on p. 36) or as you close your CraftArtist project. In 
addition, any custom stencil, punch, and brush currently stored in each 
respective tab's My Digikits category will be included in any Digikit save. 

Buying and downloading Digikits 
You can buy individual Digikits from the DaisyTrail.com shop. Provided that 
you have an internet connection, the Digikit Browser will display a selection of 
Digikits currently available for purchase from the website. 

To buy a Digikit: 

1. On the Pages context toolbar, click  Add items from Digikits. 

2. In the Digikit Browser, scroll to the DaisyTrail category. 

3. Click the Digikit you want to buy and scroll through the categories to 
browse included items. You can also use the search controls on the 
right of the dialog to narrow the list of items, or search for a specific 
item. (See Browsing on p. 29.) 

http://www.daisytrail.com/�
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4. Click any item. The Digikit Not Installed dialog is displayed and 
provides a brief summary of the Digikit.  

  

5. Click Visit Shop. The DaisyTrail.com shop opens in your web browser 
for you to proceed with your purchase. 

 If you've not already registered on DaisyTrail.com, you will have to 
register on the website. 

 If you don't want to immediately buy the Digikit, you can add the 
Digikit to a wishlist (click Add to Wishlist)—a list of items you want 
to have. You can return at a later date to make your purchase. 

Downloading free Digikits 

DaisyTrail.com offers a featured free Digikit for you to download to use in your 
projects. 

Provided that you have an internet connection, the Digikit Browser will 
automatically update to display the Digikits currently available for free 
download. Digikits made available for free download are often themed according 
to current or upcoming seasons, celebrations, public holidays, and vacations—
Independence Day, Mother's Day, Father's Day, Easter, Christmas, Halloween, 
and so on. 
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To download a free Digikit: 

1. On the Pages context toolbar, click  Add items from Digikits. 

2. In the Digikit Browser, scroll to the Latest Free kits from 
DaisyTrail.com category. 

3. Click the Digikit you want to download and scroll through the 
categories to browse included items. You can also use the search 
controls on the right of the dialog to narrow the list of items, or search 
for a specific item. (See Browsing on p. 29.) 

4. Click any item. 

5. From the dialog, click Download. 

 If you've not already registered on DaisyTrail.com, you will have to 
register on the website. 

Installing Digikits 

Once you've downloaded your purchased or free Digikit it can be installed for 
use with CraftArtist easily. 

To install a Digikit: 

1. In Windows Explorer, browse to the location of your saved Digikit. 

2. Double-click the file. 

3. Follow the on-screen instructions. 

4. Click Finish to complete installation. 

The Digikit will automatically be made available to you via the Digikit Browser. 
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Creating your own Digikits 

 

Using the Digikit Creator, you can create your own Digikit and fill it with 
custom content. Turn digital or scanned photos into frames or embellishments, 
save pages as layouts, make letters out of artistic text, add your own 
backgrounds, materials, graphic styles and stencils—these are just several of 
many ways to tailor content to your liking. You can even tweak items from your 
favourite existing Digikits to include in your custom Digikit. 

Creating a Digikit 

1. In the main workspace, drag items you want to add to your Digikit from 
your page and drop them directly onto the appropriate Content tabs. 
 
For example, you may have taken photos or scanned items that you'd 
like to use as embellishments, or applied a style to artistic text and 
would like to add them to the letters category of your new Digikit. 
 

  
 
For stencils, add your creations to the My Digikit category on the 
Stencils tab. 
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 You can refine your photos prior to adding them to a Content tab. 
Simply open PhotoLab or Cutout Studio (on the context toolbar) 
or use the Crop tool (on the Standard toolbar). 

2. Optional: In Digikit Browser, browse your existing Digikits, and add 
the items you want to include in your custom Digikit. 

3. From the Tools menu, select Digikit Creator. 
 
Items already added to the Content tab display in the Digikit Creator 
window. 
 

  

4. Select a category from the list on the left, and click Import, Add, or 
Create to add your previously created items to the Digikit Creator 
window. Once items are added, you can click Tweak to modify them. 
To rearrange the order in which they sit, click and drag them. For 
more detailed information on how to add and modify items in each 
category, please see CraftArtist Help. 

 You can create items from any of the supported image file formats, 
although one with good bit depth and transparency support (such 
as the PNG format) will produce the best results. 

5. Tag your Digikit. See Tagging on p.39. 

6. Save your Digikit. 



38 Digikits 

 

Saving Digikits 

1. Click Save Digikit. 

2. Name your new Digikit and click Done. 

You can now access your Digikit items in one of two ways: 

• From the Choose a Template dialog. 
 

 

• From the Digikit Browser. 
 

 

Loading Digikits 

From the Digikit Creator dialog, you can load any of your Digikits and add, 
adjust, and remove their items. 

 Note that any items currently added to your workspace, and to the 
Digikit Creator window, will be removed and replaced with the 
items from the loaded Digikit. 

To load a Digikit: 

1. In Digikit Creator, click Load Digikit. 

2. Browse to locate the Digikit you want to work on and click Open. 
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Tagging 
Tags are keywords, or terms, that make browsing and selecting items easier. 
Installed, featured free and purchasable Digikits are assigned with preset tags—
but you can also add your own custom tags to individual items and Digikits via 
the Digikit Creator. Once added, you'll also be able to copy and paste tags 
between items. 

To add a tag to an item 

1. Select Digikit Creator from the Tools menu. 

2. Optional: If you're not already working with the Digikit you want to 
tag, click Load Digikit and load the relevant Digikit. See Loading 
Digikits on p. 38. 

3. Select the item you want to tag by clicking its thumbnail. 

4. In the text box at the bottom of the Tags pane, type search terms you 
want to apply to the item. You can apply as many tags as you need. 

5. Click Add. 
 

  

6. To add more tags, repeat steps 4 and 5. 

7. Save your Digikit. See Saving Digikits on p. 38. 

The tags are now active and can be used as filters to search for your items in the 
Digikit Browser. 
 
To delete a tag, select it in the Tags pane and click Delete.  
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To copy (and paste) tags between items 

1. Select Digikit Creator from the Tools menu. 

2. Right-click the item from which you want to copy tags and select Copy 
Tags. 
 

 

3. Right-click a "target" item and select Paste Tags. 
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To tag a Digikit 

1. Select Digikit Creator... from the Tools menu. 

2. If you're not already working with the Digikit you want to tag, click 
Load Digikit and load the relevant Digikit. See Loading Digikits on 
p. 38. 

3. Click Tag Digikit. 

4. At the bottom of the Tag Digikit dialog, in the New Tag text box, type 
in search terms you want applied to the Digikit. You can apply as 
many tags as you need. 

5. Click Add. 
 

  

6. To add more tags, repeat steps 4 and 5. 
 
To delete a tag, select it in the Tags pane and click Delete. 
 

  

7. When you've finished tagging, save your Digikit. See Saving Digikits on 
p. 38. 

The Digikit Browser can then be used to search and retrieve Digikits and their 
items by their assigned tag names. 
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Adding, moving and deleting pages 
All pages in your project are displayed in the Pages tab, which can be expanded 
from the bottom of your workspace. 

To expand the Pages tab: 

• Click on the  button at the bottom of the workspace. Click the 
button again to collapse the tab. 

Depending on your project, the way you work with multiple pages will vary. 

For scrap pages, photobooks, stationery, and gift wrap: 

• Projects can consist of a single page, or a series of pages made up of 
various pre-defined layouts. You can add pages to your project designs 
by adding your own blank pages. 
 

  

For greeting cards only: 

• Cards use a "fixed" multiple page layout, with a back and front page 
and double inside pages. Due to the nature of folded cards, further 
pages cannot be added. 
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Adding pre-designed layouts 

CraftArtist offers a range of pre-designed layouts within each Digikit which you 
use as the basis of your new page. By customizing each layout further, you can 
quickly create your own professional looking designs. 

1. Click the Insert Page icon in the Pages tab to access your installed 
Digikits and their layouts. 
 

 

2. Select a layout from the categorized pane. 
 

 

3. Click OK. The layout is added as a new page as the last page in your 
project. 
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You can replace any page with a different layout by selecting the page first and 
simply dragging the replacement layout from the Layouts tab onto it. 

  

Adding blank pages 

 

If you don't plan to work from a pre-
designed layout, you can add blank 
pages from the Pages tab. 

The new page is added after the 
currently selected page. 
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To add a new page: 

1. On the Pages tab, select the page after which your new page will be 
added. 

2. Click  Insert Page. The new page is created and becomes the 
currently active page. 
 
-or- 

If on the last page, click the  Next Page button on the HintLine 
toolbar and use the Page Manager's Insert Page tab. 

Moving pages 

  

From the Pages tab, you can either: 

• Click and drag a page to its new position in the tab (illustrated above). 
 
-or- 

• Select a page selected and click  Move Previous or  Move 
Next. The selected page jumps one position back or forward in the 
page order. 

Deleting a selected page 

• On the Pages tab, select a page and click  Delete Page, or right-
click on the page and click Delete. 
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Copying pages 

  

Use the Copy page button to base 
your new page on an existing page. 
Page items are copied across to the 
new page. 

1. On the Pages tab, select the page you want to copy. 

2. Click  Copy Page to create an identical copy immediately after the 
selected page. 

Viewing pages 

  

You can use the 
horizontal and vertical 
scroll bars to scroll the 
page and pasteboard 
area. 

The Pages tab and 
HintLine toolbar 
provide additional 
controls to let you 
navigate between pages. 
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Navigating with the Pages tab 

Once you have added pages, use the Pages tab to quickly navigate between pages. 

1. To expand the Pages tab, click on the  button at the bottom of 
the workspace.  
 
(Click the button again to collapse the tab.) 

2. To view a specific page, simply select its thumbnail. 
 

  

 You can also use the   page controls on the HintLine toolbar to 
navigate your pages. For details, see CraftArtist Help. 

Panning and zooming 
Use panning to move around zoomed-in areas of your project. A variety of tools 
and magnifying options are available for zooming into and out of your page. 

The Pan and Zoom tools are located on the HintLine toolbar at the lower-right 
of the workspace. 
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Panning 

 

Click the 
 Pan Tool and 
then click and 
drag on the page 
to reposition it in 
the window. 

 If you're using a wheel mouse, you can hold down the middle 
button and drag anywhere on the page to reposition it in the 
window. 

Zooming 

 

The Zoom tools let 
you view and/or edit 
the page at different 
levels of detail. 

You can zoom in/out 
in increments, or by a 
user-defined or preset 
amount. 
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•  Current Zoom: Displays the current zoom percentage, with 
100% representing an actual-size page. Click on the value to select a 
preset zoom from a pop-up menu, or type over the value for a custom 
zoom percentage.  

•  Zoom Out: Click to decrease the current zoom percentage with 
each click. 

•  Zoom In: Click to increase the current zoom percentage with 
each click. 

•  Zoom Tool: Click the tool and then drag out a rectangular 
selection marquee on the page to define a region to zoom in to. The 
zoom percentage adjusts accordingly, fitting the designated region into 
the window.  
 
To zoom out, hold down the Shift key when dragging or just right-
click on the page. You can also pan around a zoomed-in page while 
the Ctrl key is pressed. To zoom to the currently selected item, choose 
Selection from the View menu. 

•  Fit Page: Click to adjust the zoom percentage so the entire page 
area is displayed in the window. 

 If you're using a wheel mouse, you can scroll the wheel forward or 
back to move up or down the page, or move horizontally left or 
right by using the Shift key and scrolling together. Try combining 
the Ctrl key and scrolling up or down for immediate in/out zoom 
control. 
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Working with layers 
You can think of layers as transparent sheets of paper upon which you can add 
and create your project items. 

 

By default, every new project you create contains two layers (labelled Layer 1 
and Background on the Layers tab). If you're working on a simple project, this 
may well be sufficient for your needs. 

If you’re working on a complex design, however, you may want to add multiple 
layers to your project. This allows you to separate groups of items into 
independent sets, each on a different layer. 

Your project is then produced by building up the layers and viewing all of the 
items on all of the layers; you can choose which layer you are editing and make 
changes without fear of modifying items on another layer. 
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Viewing layers 

 

On the Layers tab, layers 
are presented in a stack—
the uppermost layer is 
applied over any lower 
layer on the page. You can 
expand each layer entry to 
view thumbnail previews of 
the item(s) contained on 
that layer (see the "Layer 1" 
and "Background" layers 
opposite). To select an item 
in your workspace, simply 
click the item entry. To 
rename an item, click its 
name twice. 

The tab allows layers to be created, renamed, moved, deleted, reordered, frozen, 
and merged. 
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Selecting and manipulating layers 

To create a new item on a particular layer, you first need to "activate" (select) 
that layer. 

To select a particular layer: 

• Click a layer name on the Layers tab. The layer is highlighted in blue. 
 

 

To select multiple layers: 

• Hold down the Ctrl key and then click to select the layers. 

To add a new layer:  

• On the Layers tab, click the  Add Layer button to add a new layer 
above the currently selected layer. 

To rename a layer:  

• To rename a layer (e.g., to something more meaningful), click twice on 
the selected layer's name and type to add your new name. 

To delete a selected layer:  

• Select the layer’s name and click the  Delete Layer button on the 
Layers tab. 

 If you delete a layer, all of the items on it are also deleted. So if you 
want to keep any of them, move them to another layer first. 

Adjusting layer properties 

 Layer properties allow you to assign paper textures and layer 
masks, and make layers invisible and/or locked. An item’s selection colour can 
also be defined based on its current layer. You can perform these operations 
directly from the Layers tab, or by double-clicking or right-clicking on a layer 
entry. 
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Managing items on layers 

The Layers tab lets you quickly identify the layers on which items or groups of 
items were added. You can then select an item or group from the tab to select it 
on the page, as opposed to selecting the items on the page itself. 

 By default, new items are automatically added to the currently 
selected layer. This is why it is a good idea to check which layer you 
are currently working on! 

To select items on a particular layer: 

On the Layers tab, if the  Edit All Layers button is disabled, click the chosen 
layer and then: 

• Click to select the item(s) on the page. 
 
-or- 

• On the Layers tab, click the  Expand icon on the chosen layer 
entry to reveal all associated items. 
 
You'll see named items—"Artistic Text", "Group, 2 Items", 
"Picture" and so on—each with their own thumbnail preview. 
 
The frontmost item in your project always appears at the top of 
the layer's listed items (the order reflects the Z-order). 

Selection handles display around the item on the page; the displayed bounding 
box reflects the selected layer's colour. 

 Enable Edit All Layers to select any item on any visible layer. 
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The Scissor Tool 

 

 Use the Scissor Tool to cut any item or group of items on your page. For 
example, you might want to cut a material or embellishment, or add a decorative 
cut edge to a photograph. 

Cutting freeform lines 

1. Use the  Select tool to select one or more items. 
 

 

  To cut through selected items on multiple layers, ensure that 
the Edit All Layers button, on the Layers tab, is selected. (See 
Working with layers on p. 53.) 
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2. On the Standard toolbar, click the  Scissor Tool. 

3. On the Scissor context toolbar, select a scissor type from the drop-
down list. 
 

 

4. To create a freeform cut, click and drag across the item(s). 
 

  

 Unselected items that the cutting line crosses will not be split. 
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5. To remove a cut section, click it. 
 
-or- 
 
To retain a cut section, hold down the Shift key, and then click the 
section you want to retain. (All other portions of the item will be 
deleted.) 
 
-or- 
 
To retain both sections and split them apart: 

• Click the  Select tool and then click a cut section. 
 

 

• Drag the section into its new position. 
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The 3D Decoupage Tool 

 

The 3D Decoupage Tool allows you to apply a digital 3D layered effect to one or 
more selected items. Once created, you can customize the effect using the 
Decoupage context toolbar, and then fine-tune it using on-page controls. 

Just like in traditional physical decoupage projects, you can print out your item's 
decoupage layers, cut them out, and then stick them together. See Creating 
physical decoupage crafts on p. 66. 

Understanding decoupage effects 

The decoupage effect is made up of two main components: the decoupage base 
and one or more decoupage layers (from top to bottom) that are placed above 
the base. Decoupage effects typically differ in appearance because of the number, 
size and rotation of decoupage layers. 
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 Don't confuse decoupage layers with layers used in the Layers tab. 
Decoupage layers are simply tiers used to make up the effect, like 
the layers on a wedding cake. 

Applying a decoupage effect 

1. Select one or more items. 

2. Click  3D Decoupage Tool on the Standard toolbar. 
 
CraftArtist will apply a 3D decoupage effect to your item. Once the 
effect has been applied, you can customize it using the settings on the 
Decoupage context toolbar. 

To remove a decoupage effect: 

1. Select the decoupage item. 

2. From the context toolbar, select Remove.  

Customizing a decoupage effect 

With your item selected, the context toolbar provides a variety of options for 
customizing the decoupage design. 

 

Shrink 

When left unchecked, the 
original item is progressively 
cropped onto each decoupage 
layer. By checking the option 
each layer will be a smaller 
copy of the original. 
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Shape 

The drop-down menu allows 
you to apply a shape to your 
decoupage effect. The first 
menu option, Same as Base, 
will retain your original item's 
shape. If the item has 
transparent regions, its outline 
will be the decoupage base.  
If you've chosen a shape from 
the Shape drop-down list, you 
can also check Include Base to 
apply that shape to the 
decoupage base. 

 

Layers 

Sets the number of decoupage 
layers (e.g., 3 layers). 

 

Shadow and Angle 

Switches on/off the shadow 
effect on all decoupage layers. 
You can also change the angle 
of the shadow (e.g. to 135°) to 
simulate directional light 
sources. 
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Rotate Top 

Rotates the top decoupage 
layer to add artistic flair to 
your design. Lower layers will 
rotate accordingly. 
  

 

Layout for Print 

Click this button to layout each 
decoupage layer on separate 
pages for printing, and 
subsequent hands-on crafting. 
See Creating physical 
decoupage crafts on p. 66.  

 

Convert to Curves 

Select Convert to Curves to 
break apart your decoupage 
item into separate items; each 
item can then be distributed on 
the page creatively. 
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On-page fine tuning 

Once you've customized your decoupage effect using the Decoupage context 
toolbar, the top, bottom, or all layers can be fine tuned on the page with respect 
to size and offset position by using on-page slider handles. 

This allows you to size and centre the decoupage layer(s) on an area of your 
item, drawing focus to a key feature, e.g., a person's face or engagement ring. 

 

 

 

  

Creating physical decoupage crafts 

CraftArtist allows you to create a physical decoupage craft project from your 
digital decoupage item. By laying out the individual decoupage layers for 
printing you'll be able to cut out the decoupage layers from the printed layouts 
and glue them into your physical decoupage project. 

Decoupage layers can be laid out across one or more pages in either a new 
project or at the end of your existing project. 
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To create a layout for print: 

1. Select your decoupage item. 

2. On the Decoupage context toolbar, click Layout For Print. 

3. In the dialog, select either New or Append to add layers in a new 
project or the current project. 

• New: You'll be asked to create a new blank project (via Page 
Setup) to which will be added all of your decoupage item's layers, 
laid out across one or more pages.  

• Append: Your decoupage item's layers are added to a newly 
created page(s) at the end of your current project. 
 
Optional: If you want to exclude the original item from the print 
layout, ensure Leave the decoupage base on the page is selected. 
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Using stencils 

  

 

The Stencils tab provides a selection of ready-to-go, fun stencils that will add 
impact to any page. Whether you paint over them with the Brush tool, or use 
them to cut out a design from a photo, stencils provide endless opportunities for 
creativity. 

If you're feeling really creative, you can add your own stencils to the Stencils tab! 
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Adding stencils to your page 

1. On the Stencils tab, select a category from the drop-down list. 
 
The lower gallery displays thumbnails of the stencils available in the 
selected category. 

2. Click and drag a thumbnail from the gallery onto your page. 
 

  

Painting over stencils 

1. Add a stencil to your page. 

2. Click the  Brush tool. 

3. Choose a brush type from the Brushes tab and set your brush colour 
on the Colour tab. (See Adding brush strokes on p. 79.) 

 Brushes in the Airbrushes, Glitter and Natural Media categories 
are particularly suited to stencil work. 
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4. Paint over the stencil with your chosen brush. 
 

 

5. From the Standard toolbar, click  Select. 

  Stencils are set up so that paint is applied to the white section 
but not the blue section. However, the design can be switched so 
the sections are reversed. To do so, click Invert.  

6. Click the stencil, then select  Lift Stencil below the stencil. 
 
The stencil is removed, revealing the painted design beneath it. 
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Cutting out a stencil from a photo 

1. Add a stencil to you page. 

2. Drag a photo from the Photos tab and drop it on top of your stencil. 
 

 

3. Position the photo so that it displays as required inside the stencil 
outline. 
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4. Select the stencil and click  Lift Stencil to remove the stencil and 
reveal the cut out design beneath it. 
 

  

 When you create a custom stencil, an equivalent punch is also 
created in an identical category on the Punches tab. 

 Any custom items stored in the My Digikit category automatically 
appears in Digikit Creator (see p. 36), ready for adding to a custom 
Digikit. If your Digikit is not saved, your custom item will be 
discarded.  
 
To use the item again, you'll need to load the Digikit in Digikit 
Creator. 
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Using punches 

  

 

The Punches tab provides a selection of ready-to-go, fun punches that provide 
endless opportunities for creativity by making holes in items or cutting out 
shapes from items. 

If you're feeling really creative, you can add your own punches to the Punches 
tab! 
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Adding punches to your page 

1. On the Punches tab, select a category from the drop-down list.  

2. Click and drag a thumbnail from the gallery onto your page. 
 

  

3. Use the  move button to position the punch on the page, so it 
overlaps other page items. 
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Using a punch to make holes and shapes 

You can use the punch in two slightly different ways—to make holes in items or 
to cut out shapes from items. 

To punch a hole: 

1. Add a punch to your page over an item. 

2. With the punch selected, click  Punch Hole from the adjacent 
toolbar.  
 
The punch cuts through the item, removing anything underneath the 
punch's grey area. 

3. Select the "greyed out" punch. 
 
Press the Delete key to remove the punch from the page, revealing the 
punch hole. 
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To cut out shapes from item(s): 

1. Add a punch to your page over an item. 

2. With the punch selected, click  Punch from the adjacent toolbar.  

3. Optional: Delete the "greyed out" punch if you don't want to use it 
again for further punching.  

4. Click the unwanted "punched out" region to be discarded, then press 
Delete. 

The punched-out shape remains on the page. 

 If you've chosen to keep the punch on the page, just drag it to a 
different position to reveal the punched shape underneath. 

Using layers with punches 

Rather than punching the item directly below the punch, punches can also cut 
through the selected layer or all layers. This is controlled by the Layers tab. 

To punch through items on a single layer: 

1. On the Layers tab, ensure  Edit All Layers is not selected. 

2. Press the Ctrl key while clicking Punch Hole or Punch. 

To punch through all layers: 

• On the Layers tab, click  Edit All Layers. 

• Press the Ctrl key while clicking Punch Hole or Punch. 

For more information on using layers, see Working with layers on p. 53. 
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Creating your own punches 

You can create a punch from any item on your page—embellishments, frames, 
and letters work particularly well. The stencil will always be available to you 
from the current project and from any future project you make. 

 

To create your own punch: 

• Simply drag an item from your project page and drop it into any 
category on the Punches tab. 

 When you create a custom punch, an equivalent stencil is also 
created in an identical category on the Stencils tab. 

 Any custom items stored in the My Digikit category automatically 
appears in Digikit Creator (see p. 36), ready for adding to a custom 
Digikit. If your Digikit is not saved, your custom item will be 
discarded.  
 
To use the item again, you'll need to load the Digikit in Digikit 
Creator. 

Using stamp mode 
Most items can be turned into a stamp and stamped all over your page. This 
allows you to quickly replicate (copy) an item to build up your design. 

All items, including grouped and decoupage items, can be stamped, with the 
exception of multiply selected items. However, these can be grouped before 
stamping. 
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Creating and using a stamp 

1. Select an item on your page and then, click  Stamp Mode on the 
context toolbar. 
 
The cursor will update to an arrow including a copy of your item. 
 

 

2. Click anywhere on your workspace to stamp a replica of the originally 
selected item. 
 

 

3. Repeat step 2 as many times as required to create your design. 

4. To return to normal editing mode, click  Stamp Mode on the 
context toolbar. 

 You can use the Stamp context toolbar to vary the colour, size, and 
design of a stamp's line to allow a stamped item to slightly vary 
from its original. 

Once you have created your stamped items, you can use the Stamps category 
available from the Styles tab to create realistic, 'fading' stamp designs. See Using 
graphic styles on p. 161. 
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Adding brush strokes 

 

Add artistic flair to your projects with the  Brush Tool. 

The Brushes tab provides a wide range of brushes. Choose from preset, 
categorized Global brushes, or add Digikit brushes to your workspace. If you're 
feeling really creative, you can even create your own custom brushes. (For 
information on creating and customizing brushes, see CraftArtist Help.) 

You can draw and paint with your mouse or with a pen tablet. The tablet’s 
pressure-sensitive pen tip allows control of stroke width or transparency (see 
Pressure sensitivity in CraftArtist Help). 

Choosing brush types 
CraftArtist offers a wide range of brushes, divided into two main sections: 

• Digikit brushes—added to your project using the Digikit Browser, 
these are designed specifically to complement your chosen digikit. 

• Global brushes—permanently located in categories in the Brushes tab, 
these are predesigned brushes for use in any project. 

Using the Brushes tab 

The Brushes tab serves as a container for your brushes and is divided into three 
categories. 
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Document category 

The Document category shows 
the brush types used in the 
currently active project. 

This category is useful for 
selecting previously used 
brushes. 

 

My Digikit category 

The My Digikit category 
displays brushes added from 
free or purchased Digikits 
you've chosen in the Digikit 
Browser. Most Digikits contain 
brushes, but some may not. 

See Adding Digikit brushes on 
p. 81. 

 

Global category 

The Global category stores the 
supplied brush presets under a 
series of pre-defined 
subcategories. 

These brushes are available to 
all projects currently open. 

You can add, rename and 
reorder any category and even 
create nested categories within 
categories..  
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 If you're creating your own brushes you can create your own brush 
categories by right-clicking on the tab's Category drop-down list. 

Adding Digikit brushes 

The Brushes tab's My Digikit category displays the brushes added from Digikits. 
If you've previously chosen to add all the items from a Digikit, a selection of 
brush strokes will be displayed in this category. 

 Some Digikits don't contain brushes. 

To add Digikit brushes: 

1. From the Brushes tab, click Add. The Digikit Browser dialog opens. 

2. Select the Browse my items tab. 

3. Select the Brushes category from the left-hand category list. 

4. Scroll the middle pane until you find a set of Digikit brushes you like. 
Click to select the brush(es) you want to use. 

 

These brushes are added to the My Digikit category in the Brushes 
tab. 

 If you select a brush from a featured free or purchasable Digikit—
the Digikit Not Installed dialog will display and you will be 
prompted to visit the DaisyTrail.com shop. Once you've installed 
your free or purchased Digikit, the brush will be added to the 
Digikit category of the Brushes tab on selection. (See Buying and 
downloading Digikits on p. 33.) 

5. When you've finished selecting brushes, click Done. 
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Global brush types 

  The Brushes tab's Global category provides the following natural 
stroke and spray brushes: 

• Airbrushes 
Add dramatic, soft, or textured airbrush effects. 

• Edges 
Apply inner or outer edge effects to any shape or picture. 

• Embroidery 
‘Stitch’ items to your page with these colourful brushes. 

• Flowers 
Paint your pages with flower spray brushes. 

• Fun & Celebrations 
Create cheerful, fun layouts with confetti, sweets, and clouds. 

• Glitter 
Make your pages sparkle with glitter dust and glitter glue brushes. 

• Grunge 
Add aged and grunge effects to your layouts. 

• Natural Media 
Apply paint (dry, medium, and watery), acrylic, charcoal, pastel, pen, 
and watercolour natural media brush strokes. 

• Photo 
Add realistic lace, ribbon, and rope effects with this collection of photo 
brushes. 

• Special Effects 
Paint with bubbles, fire, snowflakes, splats, and more! 
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Creating brush strokes 
You can apply brush strokes directly to the page using your mouse or pen tablet. 
If you're using a pen tablet, you can control stroke width and transparency by 
adjusting pressure sensitivity (see Pressure sensitivity in CraftArtist Help). 

Once you brush stroke is on the page, you can then adjust and reshape it using 
the node tool. See Reshaping brush strokes in CraftArtist Help. 

Applying brush strokes 

1. On the Standard toolbar, click the  Brush Tool. 
 

The Brush cursor indicates that the Brush is selected and that 
you’re ready to paint. 

2. On the Brushes tab, choose a brush category from the drop-down list, 
and then select a brush stroke style from the gallery. 

3. Optional: From the Brush context toolbar, use toolbar options to set 
the properties of your brush stroke, e.g., brush, colour, width, and 
opacity.  
 

  

4. With the brush cursor, drag a brush stroke across your page. 
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5. To create new brush strokes, repeat the click and drag process. 
 

 

6. Optional: Swap to a different brush on the Brushes tab for other brush 
effects, e.g. spray brushes for flowers, then continue painting. 
 

 

 The properties currently defined on the Brush context toolbar 
settings will be adopted for subsequent brush strokes. 

7. When you have finished painting, to deselect the brush stroke press 
the Esc key. 

 For pen tablet calibration, click the  Pressure button to access 
the Pressure Studio.  

A brush stroke can be extended or reshaped, as for a straight or curved line (see 
Editing lines and shapes on p. 174). The brush stroke path can also be reversed, 
closed, or opened.
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Adding photos 

  

You can use the following methods to add photos to your project: 

• Use the Photos tab to store photos that you want to use in your 
project. You can then drag them onto the page as you need them, or 
use AutoFlow (p. 118) to quickly add them to frames you have already 
placed on your page. 

• Use the  Photo button on the Standard toolbar to add individual 
images directly to the page. 

 Use the first method if you want to add multiple photos to your 
project all at once, or if you want to add your photos to photo 
frames. 
 
Use the second method if you want to add photos to your page 
individually, or if you want to add your own embellishments to your 
layout. 



88 Working with photos 

 

Adding photos to the Photos tab 

1. In the Content tabs at the left of the workspace, click the Photos tab to 
open it. At the bottom of the tab, click Add. 

2. In the Open dialog, browse to and select the photos you want to add to 
your project. 

• To select multiple adjacent files, press and hold down the Shift 
key, click the first file in the list, and then click the last file. 

• To select multiple non-adjacent files, press and hold down the 
Ctrl key, and then click to select. 

3. Click Open. Your photos are added to the Photos tab. 
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Adding photos to the page 

To add a photo from the Photos tab: 

There are several ways to add photos to your page: 

• Drag a photo from the Photos tab directly onto the page, or onto a 
photo frame. (See Adding frames to your project on p. 113.) 
 

  

• Click AutoFlow to sequentially populate a series of photo frames with 
photos from the Photos tab. (See Using AutoFlow on p. 118.) 

• Replace the contents of a photo frame by dragging a new photo onto 
the frame.  
 
On the Photos tab, framed and unframed photos added to your 
project are denoted with a  check mark icon. This lets you quickly 
and easily identify photos used in your project.  
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To add a photo from the Standard toolbar: 

1. On the Standard toolbar, click  Photo.  

 You can also insert photos directly from an external device such as a 
camera or scanner. See Importing camera and scanner images in 
CraftArtist Help. 

2. In the dialog, browse to and select the photo you want to add, and then 
click Open. 

3. To insert the photo at default size, simply click the mouse. 
 
-or- 
 
To set the size of the photo, drag out a region and release the mouse 
button. 
 

 

If you want to import multiple photos simultaneously, you can select a range 
from within the Insert Photo(s) dialog. Each image can then be added to the 
page selectively from a Picture List flyout. 
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Replacing, resizing, and deleting photos 
Once you've placed a photo on your page, you can replace, resize, or delete it as 
required. 

Replacing photos 

1. On the Standard toolbar, click the  Select tool, and then click to 
select the photo you want to replace. 
 

  

2. On the Photo context toolbar, click  Replace. 
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3. In the Open dialog, browse to and select the photo you want to add, 
and then click Open. 
 
The image is replaced. 
 

  

 When you replace a photo in this way, the aspect ratio of the 
original photo is used. This is fine if both of your images are the 
same aspect ratio. However, if your photos are of different 
dimensions, then it is better to delete the original image and add 
the new one. 

To replace a framed photo: 

• Drag a different photo onto the frame from the Photos tab, or use 
AutoFlow to automatically replace the contents of multiple frames in a 
single step. (See Fitting photos to frames on p. 116.) 
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Resizing photos 

1. Select the photo with the  Select tool. 

2. To resize the photo, drag a corner handle. 
 

  
 
The photo's aspect ratio is preserved. To allow free resizing to any 
aspect ratio, hold down the Shift key while dragging. 

Deleting photos 

• To remove a photo from the page, select the photo and press the 
Delete key. 

• To remove a photo from the Photos tab, click its  Recycle button.  
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Cropping your photos 
CraftArtist includes the Crop Tool for cropping items and photos on the page. 
The Crop context toolbar also provides a Rule of Thirds grid to help you with 
your photo composition (see p. 96). 

 For information on working with framed photos, see Fitting photos 
to frames on p. 116. 

Cropping a photo 

1. Select a photo and then on the Standard toolbar, click the  Crop 
Tool. 

2. Click and drag an edge or corner handle towards the centre of the 
photo. 
 

 

Cropping a photo to a drawn preset shape is a great way to give your photo extra 
appeal. You can also morph your preset shape into various positions before 
cropping for complete flexibility.  
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To crop a photo to a shape: 

1. Use the  Select tool to create a multiple selection containing the 
items to be clipped. 

2. On the Arrange tab, click the down arrow to expand the  Crop 
flyout. 

3. To clip the bottom photo to the outline of the top shape, click Clip to 
Top Item. 
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Using the Rule of Thirds 

1. Select your photo and click the  Crop Tool. 

2. On the Crop context toolbar, click  Show/Hide Thirds Grid. 

3. A 3 x 3 grid is superimposed on top of the photo. 
 

  

4. Drag an edge handle to crop the photo. The grid repositions itself on 
release. 
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5. To zoom into or out of the image, use the Zoom tools displayed to the 
right of the photo. 

 

Click and drag on the 
cropped photo to pan the 
image. 

For best results, aim to 
position your main 
subject of interest at a 
point where any two 
gridlines intersect. 

Retouching photos 
When you select a photo on the page, the Photo context toolbar displays. 

 
In addition to replacing photos (p. 91), this toolbar lets you quickly remove red 
eye, adjust brightness and contrast, apply auto level and auto contrast 
adjustments, and access PhotoLab (p. 98), Cutout Studio (p. 104), and stamp 
your photos on the page. You can use these tools on unframed and framed 
photos. 

You can also convert unframed photos to “frameless” frames. (See Converting 
photos to frames on p. 122.) 

For details, see CraftArtist Help. 
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Applying PhotoLab filters 
PhotoLab is a dedicated studio environment that lets you apply adjustment and 
effect filters to photos, individually or in combination. 

PhotoLab includes filter tabs, a main toolbar, and an applied filter stack around a 
central workspace. 

Photos present in your project display in the Images tab. 

 If you can't see the Images tab, simply click the  button at 
the bottom of the dialog. 

  

(A) Filter tabs, (B) Main toolbar, (C) Main workspace, (D) Filter stack, (E) Images 
tab. 

To launch PhotoLab: 

1. Select the photo that you want to apply a filter to. 

2. Click  PhotoLab on the context toolbar. 
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Filters are stored in the 
Favourites, Adjustments, and 
Effects filter tabs, and are 
grouped into categories. 

For example, the Adjustments 
tab provides the Quick Fix and 
Pro Edit categories, while the 
Effects tab offers a wide range 
of creative effect categories. 

On the Favourites tab, you'll 
find a selection of presets 
created with individual and 
combined filters. You can add 
your own custom filters to the 
Favourites tab. (See Saving 
Favourites on p. 103.) 

When you apply a filter from 
one of these tabs, it is 
temporarily added to the Trial 
Zone that displays beneath the 
filter stack. This lets you 
preview and adjust filters 
before applying them. 
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Applying filters 

For ease of use, when you open PhotoLab, the Filters stack on the right contains 
some commonly-used filters (such as White Balance and Lighting). These 
filters are disabled by default. 
 

To apply one of the default filters, click its  Enable/Disable control to enable 
it, and then adjust the filter settings by dragging the sliders. 
 
To disable, reset, and delete a filter, see the next page. 

To add a new filter: 

1. Browse the filter thumbnails displayed on the Favourites, 
Adjustments, and Effects tabs, and click the one you want to apply. 
 
The selected filter is added to the Trial Zone, and the main window 
shows a preview of your photo with the filter applied. 
 

 

2. Experiment with the filter settings in the Trial Zone—you can drag 
the sliders, or enter values directly—to suit your requirements. 

 Some filters also offer check boxes, drop-down lists, and additional 
advanced controls.) 

3. Optional: To replace the trial filter, click a different thumbnail. 

 Selecting a new filter always replaces the current filter in the trial 
zone. 

4. To apply the filter, click  Commit to add it to the Filters stack. 
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5. Optional: 

• Repeat steps 1 to 4 to add more filters to the Filters stack. 
 
Filters are applied to a photo cumulatively, in the order in which 
they are added to the Filters stack. The most recently added filter 
always appears at the bottom of the stack. (See To reorder filters, 
below.) 

• Disable, reset, and/or delete filters in the Filters stack. (See 
below.) 

• Use zoom in/out buttons or a percentage magnification for 
detailed work. 

• Use the retouch tools to fix red eye and remove blemishes. (See 
Retouching, below.) 

6. To apply all filters in the Filters stack and close PhotoLab, click OK. 

To disable, reset, and delete filters: 

• To disable a filter, click . Click  to re-enable. 

• To reset filter values, click . Changes to settings revert to the 
filter's defaults. 

• To delete a filter, click . 

To reorder filters: 

• Drag and drop your filter into any position in the stack. A dotted line 
indicates the new position in which the entry will be placed on mouse 
release. 

To add a filter directly (without trialling): 

• Click  Add Quick Filter at the top of the Filters stack and choose 
a filter from the flyout categories. The filter is applied directly to the 
stack without being added to the Trial Zone. 
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Retouching 

PhotoLab's main toolbar provides some useful retouching tools. These are 
commonly used to correct photos before applying colour correction and effects. 

•  Red-eye tool, to remove red eye from a human subject. 

•  Spot-repair tool, to remove blemishes from human skin and 
material surfaces. 

For instructions on using the retouching tools, see CraftArtist Help. 

Selective masking 

You may sometimes want to apply a filter to selected regions of a photo, rather 
than to the entire photo. In PhotoLab, you can do this by using a “mask” to 
define these region(s). 

You can apply a mask: 

• To the areas to which you want to apply the filter. 
 
- or- 

• To the areas you want to protect from the filter. 

To apply a mask: 

1. From the  Mask drop-down list, select New Mask. 

2. In the Mask Brush pane, select the  Add Region tool. 

3. Adjust the settings to suit your requirements. For example, adjust 
Brush Size to paint larger or more intricate regions. 

4. In the Mode drop-down list, choose one of the following options: 

• Select: Choose this if you want to apply the filter only to the 
regions you paint. This is the default setting. 

• Protect: Choose this if you want to apply the filter to all areas of 
the photo, except for those that you paint. 
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5. Using the circular cursor, paint the regions to be masked (selected 
areas are painted in green; protected areas in red).  
 

 If you've not been as accurate as you'd like while painting, click 
Remove Regions then paint over the unwanted painted regions. 

6. Click  to save your mask changes, or  to cancel. 

 The mask button changes to yellow when a mask is applied. 

You can create additional masks for the same filter, as above, and then choose 
between them. You can only apply one mask at any one time. By using the Mask 
list's New From> option you can also base your new mask on an existing mask, 
which may be applied to the current filter or to any other filter in the stack. This 
is useful when working with Favourites filters that contain multiple 
adjustments. 

To edit a mask: 

• Expand the drop-down  Mask list and select the mask you want to 
edit. Click Edit Mask. 

Saving favourites 

 

You can save specific filter settings, or 
combinations of filters, as favourites for 
future use. 

PhotoLab stores all your favourites 
together in the Favourites tab. You can 
even create your own categories (e.g. 
My Adjustments) within the tab. 

To save and manage favourites: 

1. Click  Save Filter. 

2. In the dialog, type a name for your filter and choose the category in 

which to save it. (Click  to create a new category.) 
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Using Cutout Studio 

 

CraftArtist includes Cutout Studio, a powerful integrated solution for 
separating items from their backgrounds. Whether you're discarding or 
replacing a picture's background, or isolating a section of a picture to use in your 
layout, Cutout Studio lets you create eye-catching pictures quickly and easily.  

 You can also cut out your own photo frames using the Frame 
Editor, see Creating your own photo frames in CraftArtist Help. 

Opening Cutout Studio 

1. Select the photo you want to work with. 

2. On the Photo context toolbar, click  Cutout Studio. 

3. Follow the instructions outlined below. 

 You'll find detailed instructions in the Help tab at the right of the 
Cutout Studio window. 
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Choosing your approach 

The approach you take depends on your picture's content. 

•  Discard Brush Tool 
 
If your subject of interest is placed against a simple, uniform 
background (sky, a wall, etc.), it's easier and quicker to select and 
discard the background. 

•  Keep Brush Tool 
 
If the subject of interest is surrounded by a background consisting of 
complex colours or patterns (such as trees or buildings), it's easier to 
select and keep the subject. 

 

Selecting areas to discard or keep 

To select areas to discard or keep: 

1. Click the  Discard Tool or the  Keep Tool. 

2. On the horizontal toolbar, select a brush size.  

3. Optional: To adjust the degree of precision with which areas are 
selected, select the Grow Tolerance check box and adjust the value. 

4. Click and drag on the image to mark the areas you want to 
discard/keep. As you do so, CraftArtist locates similar adjoining areas 
and includes them in your selection. 

5. Repeat the click and drag process until your selection area is complete. 
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6. As you paint your image, you can view your progress using the 
buttons on the left toolbar. 

•  Show original: The default view mode. The image is shown 
in its original form. 

•  Show tinted: Areas marked to be kept are shown with a 
green tint; areas to be discarded are shown with a red tint. 

•  Show transparent: Areas marked for discarding are not 
shown. By default, these areas are replaced with a checkerboard 
background indicating transparency. 

Choosing an output type 

On the Output Settings tab, the Output Type drop-down list provides two 
output format options, Alpha-edged Bitmap, and Vector-cropped Bitmap. The 
format and settings you choose depends on what you want to do with your 
resulting image. 

 To keep a copy of the original picture on your page, ensure the 
Retain original picture option is selected. Your cutout is placed 
directly over the original picture.  

General recommendations 

Choose alpha-edged bitmap if you want to blend your cutout image into another 
image or background, or if your subject has poorly defined edges. Choose 
vector-cropped bitmap if you want to place your cutout image onto a plain or 
transparent background, or if your subject has more well-defined edges. 

To create your cutout: 

1. On the Output Settings tab, in the Output Type drop-down list, 
select Alpha-edged Bitmap or Vector-cropped Bitmap. 

2. To preview the cutout area, click Preview. 

3. To complete the cutout and return to the CraftArtist workspace, click 
OK. 
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Adding outlines and edges to photos 

 

You can enhance your photos by adding a line, brush stroke, or “fringed” edge to 
their outlines. 

 Remember that decorative picture frames can be applied to your 
photos instead of outlines and edges. 

Adding outlines to a photo 

1. Select a photo with the  Select tool. 

2. Select the Line tab. 

3. To apply a line style, click one of the following buttons: 

•  Solid Line 

•  Dashed Line 

•  Double Line  

•  Calligraphic Line 
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Solid 

 
Dashed 

 
Double 

 
Calligraphic 

4. Adjust the line width by dragging the slider. 
 

  

 To remove an outline, click the  No Line button. 
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Adding brush stroke edges 

1. Select a photo with the  Select tool. 

2. On the Line tab, click the  Brush Stroke button. 

3. On the Brushes tab, choose a category, e.g. Special Effects.  

4. Select a brush stroke style, e.g. Splash. 
 

 
 
The stroke is applied to the photo edge. 
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5. Use the following Line tab controls to adjust the effect: 

• Change the stroke width by dragging the slider. 
 

 

• Increase or decrease the flow of the brush stroke by changing the 
brush Flow value. 

Adding fringed edges 

1. Select a text item with the  Select tool. 

2. On the Line tab, click the  Edge Effect button. The Brushes tab 
will automatically jump to its Edges category. 

3. From this category, select a style for your edge effect, e.g. "Ripped". 
Your edge effect is applied to your photo. 
 

 



 

 

Adding photos to 
frames 
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Adding frames to your project 

 

 

CraftArtist Digikits include a wide selection of photo frames that you can add to 
your page. Once you've placed a frame on your page, simply drag a photo onto 
it—CraftArtist automatically fits the photo to the frame. All frames can be 
moved, resized, and rotated on the page. 

Adding frames to the Frames tab 

1. In the Content tabs at the left of the workspace, click the Frames tab to 
open it. 

2. At the bottom of the Frames tab, click Add. 

3. The Digikit Browser opens to display available frames, categorized by 
Digikit. Scroll the middle pane to the Digikit from which you want to 
add frames. You can add frames from more than one Digikit. 
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4. Click a frame to add it to your craft project, or click Add all items to 
add them all.  
The selected frame(s) is added to the Frames tab. 

5. Click Done to close the Digikit Browser. 

 If you select a frame from a featured free or purchasable Digikit—
the Digikit Not Installed dialog will display and you will be 
prompted to visit the DaisyTrail.com shop. Once you've installed 
your free or purchased Digikit, the frame will be added to the 
relevant Content tab on selection. (See Buying and downloading 
Digikits on p. 33.) 

Once the frame is added to the page, you can move, resize, and rotate it. 

 To create your own photo frames, see Creating your own photo 
frames in CraftArtist Help. 

 To remove a frame from the Frames tab, click its  Remove 
button. 

Adding frames to the page 

1. Drag a frame from the Frames tab onto your page. 
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2. Once the frame is added to the page, there are various ways to work 
with it. 

• To resize the frame, 
drag a corner handle. 

 

• To rotate the frame, 
drag the Rotate 
handle. 

 

3. To add a photo to a frame, drag it from the Photos tab and drop it 
onto a frame. 
-or- 
 
Click AutoFlow to sequentially populate a series of photo frames with 
photos from the Photos tab. (See Using AutoFlow on p. 118.) 
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Adding frames to existing photos 

If you've already added a photo to your page, you can easily add a frame to it. 

To add a frame to an existing photo: 

• Drag a frame from the Frames tab and drop it onto the photo. 
CraftArtist fits the photo to the frame automatically. 

Fitting photos to frames 
Once you have added your photos 
to the Photos tab, you can frame 
them on the page—manually by 
clicking and dragging, or 
automatically using AutoFlow. 
CraftArtist lets you rotate, zoom, 
and pan your framed photos inside 
their frames. You can even crop a 
framed photo and adjust its frame 
to follow suit! 

You can also convert photos so 
that they sit inside “frameless” 
frames. Once converted, these 
frames function exactly like the 
decorative frames you've added 
from the Frames tab. (See 
Converting photos to frames on 
p. 122.) 
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Adding individual photos to frames 

1. Add your photo(s) to the Photos tab. (See Adding photos to the Photos 
tab on p. 88.) 

2. Add a frame to your page. (See Adding frames to your project on 
p. 113.) 
 

 

3. Drag a photo from the Photos tab and drop it onto the frame. 
CraftArtist fits the photo to the frame automatically. 
 

  
 

 On the Photos tab, photos added to your craft project are denoted 
with a check mark icon. 
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Using AutoFlow 

1. Add your photo(s) to the Photos tab. (See Adding photos to the Photos 
tab on p. 88.) 

2. Add frames to your page. (See Adding frames to your project on 
p. 113.) 

3. On the Photos tab, click AutoFlow to populate multiple photo frames. 

4. The AutoFlow Photos Into Frames dialog opens, offering various 
options for filling your frames. 
 
Select any options you want to apply and click OK. 

  On the Photos tab, photos added to your page(s) are denoted 
with a check mark. 
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Cropping framed photos 

1. Select the framed photo with the  Select tool. 

2. Click  Crop directly under the frame. 
 

 

3. Drag the handles to crop the photo. 
 

  
 
(See also Cropping your photos on p. 94.) 

4. Click  Back to return to the  Select tool. 

5. Optional: Rotate, zoom or pan your cropped photo. To help with the 
composition of your photo, see Using the Rule of Thirds on p. 96. 
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Rotating, zooming, and panning 

1. Select the photo, and then click the Crop button. 
 

  

2. To rotate, or zoom into or out of the photo, click the buttons displayed 
at the right edge of the photo. 
 

  

3. To pan the photo inside its frame, click and drag on the photo. 
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4. To use the Rule of Thirds grid to help with your composition: 

• On the Crop context toolbar, click  Show/Hide Thirds Grid. 

• Click and drag on the photo to pan the image, positioning your 
main subject of interest at a point where any two lines intersect. 
(See Using the Rule of Thirds Grid on p. 96.) 

5. To close the Crop window, click  Back, or click elsewhere on the 
page or pasteboard area. 

Replacing a framed photo 

• Drag a new photo from the Photos tab and drop it onto the frame. 
CraftArtist fits the photo to the frame automatically. 

Changing a photo frame 

• Drag a new frame from the Frames tab and drop it onto the photo. 
CraftArtist replaces the existing frame and fits the photo to the new 
frame automatically. 

Deleting frames and framed photos 
You can delete frames (along with the photos inside them) from your pages. You 
can also remove frames from the Frames tab. 

Deleting frames from the page 

• Select a frame and press the Delete key. 
 
If the frame contains a photo, this will also be deleted from the page. 

Removing frames from the Frames tab 

• On the Frames tab, hover over a frame and click  Remove. 

 This process will only remove frames from the Frames tab; it will not 
delete frames already on your pages. 
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Converting photos to frames 
Photos you've added directly to your page (i.e., those that are not inside a 
decorative photo frame) can be converted so that they sit inside “frameless” 
frames. 

Once converted, these frames function exactly like the decorative frames you've 
added from the Frames tab. For example, if you use the AutoFlow feature to 
automatically populate frames in your project, photos in frameless frames will 
also be replaced. (See Using AutoFlow on p. 118.) 

 If you have used the Line tab to apply an outline or edge to your 
photo, when you convert the photo to a frame, the outline itself 
becomes the new frame. For information on applying outline and 
edge effects, see Changing line style on p. 174 and the Line tab 
CraftArtist Help topic. 

To convert a photo to a frame: 

1. Select the photo with the  Select tool. 

2. From the Tools menu, select Convert to Frame.  
 

The photo is converted to a frame, and the  Frame 
controls display beneath it. 
 
Notice also that the Photo context toolbar now include tools for crop 
manipulation. 

By clicking  Crop, you can now adjust the way your photo fits inside its 
frame by rotating, zooming, and panning. See Fitting photos to frames on p. 116. 
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Adding artistic text 
  You can create artistic text and shape text in CraftArtist. Both text types are fully 
editable, and you can apply formatting, styles, and colour fills before or after 
typing. 

Text types overview 

The following table outlines the main characteristics of artistic and shape text. 

Text type Use and characteristics 

Artistic text 
  

 

• Great for decorative 
typographic design. 

• Individual letters can be 
stretched, rotated, sheared, and 
combined with other items. 

Shape text   

 

• Lends itself well to blocks of 
body text where shape and flow 
contribute to the overall layout. 

• Conforms to the containing 
shape. You can't manipulate 
individual letters, but you can 
achieve unique text flow effects 
by varying the container’s 
properties. 

• Shape text does not have a line 
property. 
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Letters (Content tab)    

 
 

 For more information, see 
Adding letters on p. 23. 

• Great for decorative 
typographic design. 

• Available from Digikits. 

• Letters exist as individual items 
on the page. 

  

Adding artistic text 

1. On the Standard toolbar, click the  Text tool. 

2. To create text at the default size, click on your page to set a text 
insertion point. 
 
-or- 
 
Click and drag on your page to set the size of the text insertion point. 
 

  

• To set text attributes before typing, adjust the settings on the Text 
context toolbar. (See Formatting text on p. 133.) 

 

• To set text colour before typing, set the Line and Fill swatches on 
the Colour tab. (See Changing line and fill colour on p. 197.) 

3. Start typing. To start a new line of text, press the Enter key. 
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Adding shape text 

1. Create a shape either from the QuickShape flyout or by closing a 
drawn line. 

2. With the shape selected, click the  Text tool. 
 
A cursor will appear centred in the shape. 

3. Start typing. To start a new line of text, press the Enter key. 
 
Your text automatically flows within the shape. 
 

 

 To set text attributes before typing, adjust the settings on the 
Text context toolbar. (See Formatting text on p. 133.) 

 To set text colour before typing, set the Line and Fill swatches 
on the Colour tab. (See Changing line and fill colour on p. 197.) 
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If you’ve typed more text into a shape than it can display, an  Overflow 
button displays below the shape when it’s selected. 

  

• Click the  Overflow button (or the  AutoFit button on the 
Text context toolbar) to reduce the size of the text. 

• To reveal all the text without changing the font size, enlarge the shape. 

• To extract text from a shape (as an artistic text item), right-click the 
shape and click Detach as New Item>Text. To detach the text from its 
containing shape, simply drag it. 

Working with text on the page 

To select an entire artistic or shape text item:  

• Click it with the  Select tool. 

To edit a text item:  

1. Select the item with the  Select tool, and then click the  Edit 
button that displays below the item. 
 
-or- 

Select the item with the  Text tool. 
 
A text edit cursor is inserted inside the text. 

2. Click and drag to select the text you want to edit, and then retype. See 
Editing and deleting text on p. 131. 
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To move a text item:  

• Select it, and then drag it. 
 
-or- 
 
Click and drag its  Move button. 
 

  

To resize a text item:  

• Select it and drag a corner resize handle. 
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To rotate a text item:  

• Select it and drag its Rotate handle. 
 

  

To apply text formatting:  

• Select the text, and then adjust the settings on the Text context toolbar. 
See Formatting text on p. 133. 

You can also rotate and shear text items, and apply shadows, transparency, and 
other effects. For details, see: 

• Rotating and shearing items (CraftArtist Help) 

• Adding drop shadows (p. 147) 

• Applying transparency (p. 156) 

• Adding outlines and edges to text (p. 137) 

• Applying other 2D filter effects (p. 150) 

 You can also add frequently used text as a reusable sentiment. See 
Sentiments on p. 140. 
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Editing and deleting text 
You can edit and delete artistic text and shape text directly on the page, or in the 
Edit Text dialog (for details on working in the Edit Text dialog, see CraftArtist 
Help). 

To edit text on the page:  

1. Select the item with the  Select tool, and then click the Edit button 
that displays below the item. 
 

  
 
-or- 
 

Select the item with the  Text tool. 
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2. A flashing text edit cursor is inserted inside the text. 
 

  

3. Optional: Click and drag to select the text you want to edit. 
 

  

4. Type your new text. 

 To cut, copy, and paste text, use the standard Windows keyboard 
shortcuts. 

To delete an entire text item:  

1. Select a text item or shape with the  Select tool. 

2. Press the Delete key. 
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To delete selected characters or words: 

1. Select a text item or shape with the  Select tool. 

2. Click the  Text tool. 
 
A flashing text edit cursor is inserted inside the text. 

3. Click and drag to select the text you want to delete, and then press the 
Delete key. 

Formatting text 
You can select and format artistic and shape text directly on the page using the 
Text context toolbar, the Format menu, or the Edit Text dialog. 

Selecting text for formatting 

To format an entire text item: 

1. Select the item with the  Select tool.  
 

  

2. Use the Text context toolbar or Format menu to apply formatting, as 
described below. 
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To format selected letters or words: 

1. Click the  Text tool, and then click and drag to select one or more 
characters or words. 

2. Use the Text context toolbar or Format menu to apply formatting, as 
described below. 
 

  

Using the Text context toolbar 

 

The Text context toolbar lets you apply basic text attributes, such as font type, 
point size, font style, alignment options, and so on, to selected text. 

To format text from the Text context toolbar: 

1. Select a text item, a character, or a group of characters. 

2. On the Text context toolbar, select from toolbar options to format 
your text to your liking. 
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Fitting text to a path 
CraftArtist allows you to make artistic text conform to a curved baseline (such as 
a drawn freeform line or curve), custom shape or a preset shape (QuickShape). 

 

Putting text on a path 

To fit text to a path: 

1. Select the curve or shape. 

2. Click the  Text tool. 

3. Hover over the curve or shape's outline until you see a  cursor, 
then click at the point on the line where your text is to begin. 

4. Begin typing your text. The text will be placed along the curve or 
shape. 
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Alternatively: 

1. Create your artistic text. 

2. Create a freehand, straight, or curved line or a shape. 
 

 

3. Select both items and on the Tools menu, click Fit Text to Curve. The 
text now flows along the specified path. 
 

 

To flow text along a preset path: 

1. Select your artistic text. 

2. From the context toolbar, click the down arrow on the  Preset 
Text Paths button and select a preset curve from the drop-down list 
on which the text will flow. 
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Adding outlines and edges to text 
You can create interesting text effects by adding various line, brush stroke, and 
“fringed” edge styles to your artistic text items. 

 You cannot apply lines and edges to shape text. 

Adding outlines to artistic text 

1. Select a text item with the  Select tool. 

2. Open the Line tab. 

3. To apply a line style, click one of the following buttons: 

Line tab button Effect achieved 

 Solid Line 

  

 Dashed Line 

  

 Double Line 

  

 Calligraphic Line 
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4. Adjust the line width by dragging the slider. 
 

  

 To remove an outline, click the  None button. 

Adding brush stroke edges to artistic text 

1. Select a text item with the  Select tool. 

2. On the Line tab, click the  Brush Stroke button. 

3. On the Brushes tab, select a brush stroke style. 
 

 
 
The stroke is applied to the text outline. 
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4. Use the following Line tab controls to adjust the effect: 

• Change the stroke width by dragging the slider. 
 

 

• For spray brushe strokes only, increase or decrease the flow of the 
brush stroke by changing the brush Flow value. 

Adding fringed edges to artistic text 

1. Select a text item with the  Select tool. 

2. On the Line tab, click the  Effect button. 

3. On the Brushes tab, select a brush stroke style. 

4. Use the following Line tab controls to adjust the effect: 

• To apply the edge style inside the edge of the text, select the Inner 
Edge check box. 

• Change the stroke width by dragging the slider.  
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Adjusting the outline distance 

Use the Line tab's Offset value to change the distance between a text item and its 
outline. 

To adjust line offset: 

1. Select a text item with the  Select tool. 

2. On the Line tab, adjust the Offset value to achieve the desired effect. 
 
You can click the up/down arrow buttons; click the right arrow button 
and drag the slider; or type a value and press Enter. 
 

  

Sentiments 

 

If you're always stuck for words, CraftArtist can help you add sentiments and 
quotes to your designs with just a few simple clicks! 

You can create a new sentiment from any artistic text item. In fact, you can even 
create a single sentiment from several text items! This makes it really easy to 
design and use complex text designs over and over again quickly and easily! 
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Adding sentiments to the page 

1. On the page context toolbar, click  Insert Sentiment. 
 
-or- 
 
On the Insert menu, click Sentiment or Quote. 

2. In the Insert sentiment or quote dialog: 

• In the left pane, select the category and/or sub-category that fits 
your design. 

• In the right pane, click on the sentiment that you want to use. 

• Click Insert. 

3. To create the sentiment at the default size, click on your page. 
 
-or- 
 
Click and drag on your page to set the size of the sentiment. 
 

  

4. The sentiment is added as artistic text. 
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Editing sentiments on the page 

Once you have added your sentiment to the page, it behaves in the same way as 
any other artistic text item. See the help topics contained within Working with 
Text in the Table of Contents for further details. 

Creating new sentiments 

1. Create and select your artistic text item(s). 
 

 

2. Click the  Add as sentiment button. 

 Why not start with an existing sentiment and then personalize it as 
we've done in this example? 
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3. In the Create new sentiment or quote dialog, select the category 
(indicated by a yellow folder icon) into which you want to add the 
sentiment, then: 

• Select an existing sub-category and click Add > Add To Existing. 
 
-or- 

• Type a name for the new sub-category and click Add > Add New. 
 

 

 To create an entirely new category for your sentiments, see 
Managing sentiments in CraftArtist Help. 

4. Your new sentiment will now be available from the Insert sentiment 
or quote dialog. 
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 Having a party or two? You can also use sentiments to quickly create 
advance text layouts. In our example, we used several text items to 
create this standard invitation sentiment. 
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Adding drop shadows 
The Styles tab provides a wide variety of preset drop shadows which you can 
quickly and easily add to items on your page. 

Using the Styles tab 

1. With your item selected, on the Styles tab, select Shadows from the 
drop-down list. 

2. Click any shadow thumbnail to apply a shadow to your selected item. 
 

 

 For more details on using graphic styles, see Using graphic styles on 
p. 161. 

If you want more control of your item's shadow, you can use the Shadow Tool. 

Using the Shadow Tool 

The  Shadow Tool is great for allowing freeform control of a drop shadow 
effect. With its on-the-page control handles and supporting Shadow context 
toolbar, the tool offers various adjustments such as Opacity, Blur, and X (or Y) 
Shear. 
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Simple shadow (drag from item centre) 

 

 
Offset shadow (showing control handles) 

 

A - Origin of shadow, B - Blur, C - Opacity, X - X-axis shear, Y - Y-axis shear 

 
Skewed offset shadow (adjusted Origin and X Shear) 
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To apply a drop shadow with Shadow Tool: 

1. Select the item and click the  Shadow Tool on the Standard 
toolbar. Control handles display to allow for shadow adjustment, as 
illustrated above. 

2. Drag across the item to create a drop shadow. 

3. Change blur, opacity, or shear properties by dragging the respective 
control handles (or via the displayed context toolbar). 

 Once you’ve created a basic shadow, you can further edit it as 
needed using the Filter Effects dialog on p. 150. 

To change a shadow's colour: 

• Select the item, choose the Shadow Tool, then select a colour from the 
Colour tab. 

To remove the shadow from an item: 

• Double-click the item while the Shadow Tool is selected.  
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Applying other 2D filter effects 

Changing material depth 

 
  

Material Depth 

  

If you've manipulated materials you've 
added to the page, perhaps by cutting out 
with the Scissor Tool, you can apply some 
depth by applying an embossing effect. 

• On the Styles tab, adjust the 
Material Depth setting. 
 
(The greater the value, the more 
pronounced the embossed effect.) 

Making feathered edges 

  
Feather Edge  

  

Feathering applies a softer edge to design 
items such as embellishments or cut 
materials. The effect also looks great when 
applied to photo edges. 
  

• On the Styles tab, adjust the 
Feather Edge setting. 
 
(This is the distance inside the 
item's outline from which 
feathering will be applied.) 

 The Feather option in the Filter Effects dialog (see CraftArtist Help), 
offers independent control of Opacity and Blur, which can also be 
used in conjunction with other 2D filter effects. 
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Applying filter effects 

For more advanced control of filter effects, CraftArtist provides a variety of filter 
effects that you can use to transform any item. The following examples show 
each filter effect when applied to the letter "A". 

    

Drop Shadow Inner Shadow Outer Glow Inner Glow 

    

Inner Bevel Outer Bevel Emboss  Pillow Emboss  

    

Gaussian Blur Zoom Blur Radial Blur Motion Blur 

   

  

Colour Fill Feather Outline   

You can also use the Shadow Tool to apply a shadow to an item directly on your 
page. Control handles let you adjust shadow blur, opacity and colour. 
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To apply 2D filter effects: 

1. Select an item on your page and then click Format>Filter Effects, or 
right-click the item and choose Filter Effects. 

2. Optional: By default, effects are applied directly to the selected item 
on the page. 

To view applied effects in a preview window, click  Show/Hide 
Preview button. (This approach lets you work on your effects in 
isolation, without other page items in view.) 

3. To apply an effect, select its respective check box and then adjust the 
settings that display on the right. 
 
Adjust the sliders or enter specific values to vary the combined effect. 
(You can also select a slider and use the keyboard arrows.) Options 
differ from one effect to another.  

4. Optional: If you want the effect to remain fixed if you resize the item, 
clear the Scale with object check box. With the box selected, the 
effect's extent adjusts relative to any change in the item's size. 

Creating outlines 

CraftArtist lets you create a coloured outline around items, especially text and 
shapes (as a filter effect). For any outline, you can set the outline width, colour 
fill, transparency, and blend mode. The outline can also take a gradient fill, a 
unique contour fill (fill runs from the inner to outer edge of the outline width), 
or pattern fill and can also sit inside, outside, or be centred on the item edge. 

As with all effects you can switch the outline effect on and off. You'll be able to 
apply a combination of 2D or 3D filter effects along with your outline, by 
checking other options in the Filter Effects dialog. 
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Applying 3D filter effects 
As well as 2D filter effects, CraftArtist provides a variety of 3D filter effects that 
you can use to transform any item. Such effects are selectable from the Styles tab 
which offers an impressive choice of ready-to-go simulated natural and 
manufactured surfaces. When applied to drawn items, previously "flat" 
appearances are brought to life by application of depth and texture. 

 

The Styles tab displays a variety of thumbnail presets in the Instant Effects 
category (Animals, Glass, Metallic, etc.). 

Click any thumbnail to apply it to the selected item. 

  

 None of these 3D effects will modify an unfilled item—you’ll need to 
have a fill there to see the difference they make! 
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Customizing 3D filter effects 

Once an effect has been applied, you can customize it via a Filter Effects dialog. 

1. Select the item with a 3D effect applied and then click Format>Filter 
Effects, or right-click the item and choose Filter Effects. 

2. In the Filter Effects dialog, you'll notice the 3D Effects and 3D 
Lighting boxes already selected. 

3. Experiment with the effect by selecting various subcategories (e.g., 3D 
Bump Map, 2D Bump Map, etc.), and then adjusting the options on 
each pane. 

Customizing Styles tab effects 

Once you've customized an item's effect locally, you can add the effect to the 
Styles tab so that it will be available to use again. You can also delete effects from 
the Styles tab. 

To add an item's effect to the Styles tab: 

1. Select the item with the effect applied and then choose Create Graphic 
Styles from the Format menu. 
 
The Graphic Style Editor dialog opens. 

2. Optional: Make any changes to the effect from the settings list on the 
left. 

3. In the Attributes section, type a name for the effect. 

4. In the Category section: 

• Select a category from the Main drop-down list (e.g. Instant 
Effects). 

• Select a subcategory from the Subcategory drop-down list. 

5. Click OK. 
 
The new effect thumbnail displays in the selected Styles tab category. 

To delete an existing effect from the Styles tab: 

• Right-click the effect's thumbnail and choose Delete Style. 
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Paper textures 
Paper textures simulate various real media textures of varying roughness and 
"feel", such as Canvas, Cartridge, Embossed, Parchment, and Watercolour. 

As a paper texture is a layer property, the layer's texture is applied to all items on 
that layer. A different texture can only be applied to a different layer (and to all 
its items). 

 

Applying paper textures 

1. On the Layers tab, select the layer on which to apply a paper texture. 

2. Click the  Paper Texture button displayed after the chosen layer's 
name. 

3. In the Bitmap Selector dialog, select the Paper Textures category. 
 
A gallery of texture thumbnails displays. 

4. Choose a thumbnail and adjust Scale and Opacity values if required. 

5. Click OK. 

On the Layers tab, the layer's Paper Texture button changes to , indicating 
that a paper texture has been applied. 

All existing items on the layer, and any new items added to the layer, will adopt 
the applied paper texture. 
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Removing a paper texture 

1.  On the Layers tab, locate the layer whose texture you want to 
remove and click the Paper Texture button. 

2. In the Bitmap Selector dialog, click the Remove button. The paper 
texture is removed from the layer and all items on it. 

Applying transparency 
Transparency effects are great for highlights, shading and shadows, and for 
simulating realism.  

Transparencies work rather like fills that use "disappearing ink" instead of 
colour. The more transparency in a particular spot, the more "disappearing" 
takes place there, and the more the item(s) underneath will show through. 

For example, in the illustration below, the butterflies have a 0% solid 
transparency, a 0% to 100% gradient transparency and a 50% solid transparency. 

 

Solid transparency distributes the transparency equally across the item. 
Gradient transparencies are created by drawing a path across the item; Linear 
transparencies are drawn by default but other categories such as Radial, Ellipse, 
Conical, Plasma, Square, Three Points, and Four Points can be created. 
Composite transparencies affect all items in a group. 
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Applying solid transparency 

The Colour tab hosts a Transparency slider that 
controls the level of solid transparency applied to 
currently selected items. 

The far left of the slider (the blackest region) 
represents 0% transparency (i.e. the item will 
appear opaque). The far right (the checkered 
region) represents 100% transparency. All other 
levels of transparency are represented across the 
slider and the associated percentage indicated 
above the slider.  

 

To apply solid transparency from the Colour tab: 

1. With your item(s) selected, go to the Colour tab. 

2. Adjust the Transparency slider to set the level of transparency. The 
transparency is applied to the selected item(s) uniformly. 

Applying gradient transparency 

Just as a gradient fill can vary from one colour to another across an item, 
gradient transparency (from transparent to opaque) can be applied by drawing a 
gradient transparency path across an item. The gradient transparency path links 
the From and To handles (e.g., from 0% transparency (black handle) to 100% 
transparency (white handle)). 
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The Transparency Tool displays an item’s gradient transparency, indicated by 
two or more handles situated along a path. You can reposition the handles to 
adjust the transparency’s starting point or end point. 

For transparencies with multiple handles, you can also adjust the intermediate 
levels of transparency. Each handle has its own value, comparable to a key colour 
in a gradient fill (see Applying gradient fills on p. 201). Each selected handle's 
value can be altered directly on the page or in the Gradient Transparency Editor 
dialog. 

To apply gradient transparency with Transparency Tool:  

1. Select an item. 

2. Click the  Transparency Tool on the Standard toolbar. 

3. To apply a simple Linear transparency (grading from 0% transparency 
to 100% transparency), click and drag across the item to define the 
transparency path. 
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Changing transparency type 

By default, the Transparency Tool applies a simple linear transparency on the 
drawn path. However, the tool's context toolbar lets you change to one of several 
transparency, e.g., Radial, Conical, Ellipse, Plasma, etc. 

The path's appearance may change to reflect the transparency type, but the 
principles of editing the transparency path are the same. 

 

 

Editing gradient transparency 

Once you've applied a gradient transparency, you can adjust its path on the item, 
and the level of transparency along the path. You can even create more complex 
transparency effects by adding extra handles to the path and assigning different 
values to each handle. 

To adjust the transparency path:  

1. Select the item with a gradient transparency applied. 

2. Click the  Transparency Tool on the Standard toolbar. 

3. Drag the displayed handles to new positions. You'll notice the effect 
change as you drag a handle. 
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Editing a gradient transparency path is similar to editing a gradient fill path 
(see Editing a gradient fill path on p. 202). Adding a level of transparency means 
varying the transparency gradient by introducing a new handle, and assigning 
the handle a particular value. For transparencies with multiple handles, each 
handle has its own value, comparable to a key colour in a gradient fill. 

You can either edit the path directly using the Transparency Tool, or use the 
Gradient Transparency Editor dialog (similar to the Gradient Fill Editor). Both 
methods let you define key values along the path. 

For details of how to edit and manage transparency in the Gradient 
Transparency Editor dialog, see CraftArtist Help. 

Composite transparency 

An individual item can take a specific transparency setting. However, when 
multiple items are grouped (see CraftArtist Help), the group can be given a 
composite transparency, affecting the group as if it were a single item. 
Composite transparency is possible by selecting a group and then using the 
Transparency slider on the Colour tab. 
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Using graphic styles 

 

The Styles tab contains 
multiple galleries of 
pre-designed styles that 
you can apply to items. 

For enhancing 
embellishments and 
materials, try 
categories such as 
Shadows, Stickers, 
Stamps and 
Silhouettes. For drawn 
items (e.g., shapes) you 
can use categories such 
as Bevels, Blurs, Edges, 
and many more styles. 

The key with the Styles 
tab is to experiment 
freely with your design 
until you get the style 
that works for you!  

Styles are cumulative in that when a style is applied to an item it complements 
the item's other properties, rather than replaces them. As an example, if an item 
already had a line colour and fill, these properties would be maintained after 
adding, e.g., a perspective shadow. However, if another shadow style is applied, it 
will replace the perspective shadow. 

Properties of fill, line, text, and effects, once applied to an item, can be 
subsequently saved as a custom graphic style (see p. 162), which will be available 
to any project, via the Styles tab or via Digikit.  
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To apply a graphic style to one or more items: 

1. Display the Styles tab. 

2. Expand the drop-down menu to select a named style category (e.g., 
Shadows), then pick a subcategory by scrolling the lower window. 

3. Preview available styles as thumbnails (cog shapes are shown by 
default) in the window. 
 

 

4. Click a style thumbnail to apply it to the selected item(s).  

Create your own custom graphic styles (in Styles tab) 

The Styles tab also lets you store your own graphic styles if you would like to 
reuse them—the style is made available in any CraftArtist project. You can add 
(and delete) items to either preset or custom categories and subcategories. 

You can either apply properties (e.g., fill, line, text, or 2D/3D effects) from 
scratch or apply a preset style and modify it; either method lets you save the 
properties to a named graphic style. 

As each graphic style includes settings for a host of properties you can include or 
exclude certain properties, making this a powerful design tool. 

 Any custom items stored in the My Digikit category automatically 
appears in Digikit Creator (see p. 36), ready for adding to a custom 
Digikit. If your Digikit is not saved, your custom item will be 
discarded.  
 
To use the item again, you'll need to load the Digikit in Digikit 
Creator. 
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To create a new graphic style based on an selected item's properties:  

1. Select Create Graphic Styles from the Format menu. 
 
The Graphic Style Editor dialog appears, with a list of graphic 
properties on the left and a four-pane preview region, showing how 
the graphic style looks on sample items (Cog, Rounded Rectangle, 
Sample Text, or the Letter A). 

  

2. Optional: Click to expand or collapse sections within the list of 
attributes. This reveals which attributes are currently set. Uncheck any 
properties you want to exclude from the style definition, or check any 
you want to additionally include. 

3. Optional: If you want to modify any property, select its value and edit 
via flyout, drop-down list, dialog, or input box. 
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4. Type a Name to identify the style thumbnail, and optionally, save to a 
different Preview Type (see above) instead of the default cog shape; 
this preview type will show in the Styles tab. 

5. Select a Main category and Subcategory (these are shown in the Styles 
tab) where you want to save the style thumbnail to. You'll need to 
create any custom categories in advance. 

6. Optional:  To help find styles in the Styles tab, add tags to your 
style definition by entering text (e.g., 3d) and clicking the Add Tag 
button. You'll be able to search for the style via the Styles tab. See 
Finding styles in CraftArtist Help. 
 

 

7. Click OK. A thumbnail for the new graphic style appears in the 
designated Styles tab category. 

Once a graphic style is listed in a gallery, you can modify it or create a copy (for 
example, to define a derivative style) by right-clicking on its thumbnail and 
choosing Edit Style or Copy Style. 
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To create a graphic style from scratch: 

1. In the Styles tab, navigate to a category in which you want to create 
your new style. 

2.  Click  Add New Graphic Style. 
- or - 
 
Right-click any thumbnail and select Add New Style. 

3. From the dialog, configure attributes via flyout, drop-down list, dialog, 
or input box. 

Create your own custom graphic styles (in My Digikits) 

CraftArtist lets you create graphic styles in the Styles tab's My Digikit category. 
This means the style can be stored along with other items selected from other 
Digikits using the Digikit Browser, optionally being saved to a custom Digikit in 
Digikit Creator.  

To create your own style: 

• Simply drag an item from your page and drop it into the My Digikit 
category on the Graphic Styles tab. 

 You can also create custom graphic styles directly from the Graphic 
Styles category in Digikit Creator (see p. 36).  
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Adding lines and 
shapes 
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Using QuickShapes 

 

The QuickShapes flyout provides a wide 
variety of commonly used shapes that you 
can instantly add to your page. 

To create a QuickShape:  

1. Click  Shapes on the Standard toolbar and select a shape from the 
flyout. 

2. Click and drag on your page to draw your QuickShape at a specific 
size. To constrain the aspect ratio (for example, to obtain a square or 
circle), hold down the Shift key while dragging. 

 New QuickShapes adopt the currently set line and fill, as defined on 
the Colour tab. See Changing fill and line colour on p. 197. 

Once you've drawn your QuickShape, you can adjust its properties—for 
example, apply solid fills (p. 197), gradient fills (p. 201), or transparency effects 
(p.156). You can even use sliding control handles to create variations on the 
original QuickShape. 

You can also use the QuickShape context toolbar, situated above the workspace, 
to swap QuickShapes and adjust line weight, colour, style, and more. 

All QuickShapes can be positioned, resized, and rotated. What's more, you can 
adjust their appearance as soon as they are drawn, or at a later time. 
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To adjust the appearance of a QuickShape:  

1. Select the item with the  Select tool. 

2. Click the  Edit button displayed beneath the item. This reveals 
sliding round handles around the shape. (Different QuickShapes have 
different handles.) 

3. Drag the handle to change the appearance of a QuickShape. 

For example, dragging the top sliding handle to the right on the Quick Star 
below will produce a very different star shape. 

 

Drawing lines and shapes 
You can draw straight or curved lines. As soon as you draw a line you'll see its 
points appear. The line between any two points is called a line segment. 
Freeform and curved lines usually have many points; straight lines have only 
two. 

All lines and line segments have line properties such as colour and weight 
(thickness). For details on applying colour to lines and shapes, see Changing line 
and fill colour on p. 197. 

When a line, or series of line segments, forms a complete, enclosed outline, it 
becomes a new closed item called a shape. Because shapes can be filled with a 
solid or gradient fill, they have fill properties as well as line properties. 
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Freeform Line 
(Pencil Tool) 

Curved Line 
(Pen Tool) 

Closed Line (Shape) 
(Pen Tool) 

Drawing freeform lines 

1. Click the  Pencil Tool on the Standard toolbar. 

2. Click once, then drag across the page, drawing a line as you go. The 
line appears immediately and follows your mouse movements. 

3. To end the line, release the mouse button. The line will automatically 
smooth out using a minimal number of points. Note the dots 
indicating its points—at the two ends, and at each point where two 
line segments come together. 

4. Optional: To set the degree of smoothing to be applied to the line (and 
subsequent lines), set the Smoothness value (by entering a value or 
adjusting the slider) on the context toolbar.  
 

  

 To draw a straight line, hold down the Shift key down as you drag.  
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Drawing curved lines 

Curved lines are created as a series of connected line segments (which may be 
curved or straight) using a series of "connect the dots" mouse clicks. New line 
segments are added all the time. The tool is designed for drawing complex, 
combination curves and shapes in a highly controlled way. 

1. Choose the  Pen Tool from the Standard toolbar. 

2.   From the displayed context toolbar, choose to create your 
drawn segments in Smooth joins or Sharp joins creation mode. By 
default, you'll be in Smooth joins mode. 

3. Click where you want the line to start (1). 

4. Click again for a new point and drag out a pair of control handles 
which orbit the point (2). (Control handles act like "magnets," pulling 
the curve into shape. The distance between handles determines the 
depth of the resulting curved line.) Release the mouse button to create 
your curve segment (3). 

  
  

(1) (2) (3) 

5. To extend an existing line, click beyond the end of your current curve 
to create a new point (thus creating another curve segment). Normally, 
curve segments end in a symmetric (evenly rounded) corner (4), with 
control handles locked together.  
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(4) (5) 

6. However, you can press the Alt key while drawing the segment to 
define a "cusp" or sharp corner (5). This locks the control handle on 
the last created point. 

7. To end the line, press Esc or choose a different tool. 

Drawing shapes 

To close a freeform line or curve as you draw: 

• For irregular shape, simply extend the line back to its starting point. 
Shapes have an interior which is filled with the current default fill (see 
Changing fill and line colour on p. 197) when the line or curve is 
closed. 

To close an existing line or curve (with a straight line):  

1. Select the line or curve with the  Select tool (Standard toolbar). 

2. Click the  Edit Points button displayed beneath the item. 

3. Select  Close Curve button from the context toolbar. A Straight 
segment appears, closing the curve. 

If you're trying to draw a cartoon outline made up of many independent curves 
(e.g., a rose) you may want to fill each curve without closing it. This is made easy 
by using the Fill-on-Create feature. 
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To fill an unclosed curve automatically:  

1. Select the Pencil, Pen, or Brush tool (Standard toolbar). 

2. On the context toolbar, click to enable  Fill-on-Create, and then 
select a fill from the Colour tab. 

3. Draw a freeform line and the resulting curve will automatically fill 
with the current fill colour. 

Editing lines and shapes 
All items, lines, and shapes are composed of one or more line segments (which 
can be straight or curved) that are joined at their points. To edit a line or shape, 
you can manipulate its segments and/or points, redraw lines, reshape lines (by 
moving or adding/deleting points), or join two or more lines together. 

While editing lines and shapes is intuitive, you can find out more in the 
CraftArtist Help. Line redrawing, extending, reshaping, and changing 
points/line segments are covered in detail.  

Changing line style 

 

All lines, including those that enclose 
shapes, have numerous properties, 
including colour, style, line ends, 
weight, join, cap, and offset. 
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Using the Line tab, you 
can adjust plain line 
properties for any 
freeform, straight, or 
curved line, as well as for 
the outline of a shape or 
photo.  

 

Changing line colour 

Colour swatches present in a Digikit automatically become available in the 
Colour tab when it is loaded. For details on adding or editing plain line colours, 
see Changing fill and line colour on p. 197. 

Changing line style 

  

A series of buttons arranged 
along the top of the Line tab 
set the line style. 

Solid Line, Dashed Line, 
Double Line, Calligraphic 
Line, and Brush Stroke styles 
can be applied. 

A fringed Edge Effect style 
can also be applied to shapes, 
text, and especially to photo 
edges. 
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To change line style: 

• Click a button to set the line style—only one style can be set at any one 
time. Click another button to jump to that style. 

Once a style is selected you can choose line ends for most styles (except Brush 
Stroke and Edge Effects). 
 

 

For some styles, variations are also available. 

For example, for a  Dashed Line or  Double 
Line style, additional dash patterns (below) and double 
line options can be selected. 

To select a line end: 

•  From the  and  drop-down menus, pick a line 
start and end. 

Other styles such as Dashed Line and Calligraphic Line offer further 
customization of the chosen style. 

Two styles, Brush Stroke and Edge Effects, let you apply a brush, chosen from 
the Brushes tab, to the outline of a photo or artistic text. (See p. 107 and p. 137, 
respectively.) You'll see your current brush shown on the Line tab.  

For changing line caps and ends, see CraftArtist Help. 

Changing line width 

 

On a selected line, curve, or shape, drag the 
Weight slider on the Line tab. 

To turn off the line, set the value to 0.0pt. 
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Adjusting line offset 

 

On a selected line, curve, or shape, adjust the Line tab's Offset value. This lets 
you adjust the distance between an item, brush stroke, etc., and its outline. To do 
this, you can click the up/down arrow buttons, type a value directly, or click the 
right arrow and drag the slider. 
 

 

Copying an item's formatting 
Use Format Painter to copy an item’s line and fill properties directly to another 
item (you can even copy between line/shape and text items). 
 

 
 

 The Format Painter is particularly useful if you've taken the time to 
fine-tune an item's appearance (e.g., you may have applied a 
complex fill or combination of filter effects), and want to apply the 
same format to other items on your page. 
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To apply an item’s formatting to another: 

1. Select the item whose formatting you wish to copy. 
 

 

2. Click  Format Painter on the Standard toolbar. When you click 
the button, the selected item's formatting is "picked up." 
 

 

3. Click the item to which you want to apply the "picked up" formatting. 
The second item becomes selected and the formatting is applied. 
 

 

• To cancel Format Painter mode, press Esc, click on a blank area 
of the page, or click any other tool button. 

• While in Format Painter mode, to select an item without pasting 
formatting, hold down the Shift key and then select the item. 

• When copying formatting from one text item to another, text 
properties such as font and style are also passed along. 



 

 

Crops, erasing, 
and masking 
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Combining, cropping, and joining items 
CraftArtist provides the powerful Combine, Crop, and Join (Add, Subtract, and 
Intersect) commands, which you can use on multiple selections to create new 
shapes. 

For easy access to these commands, use the buttons on the Arrange tab. You'll 
also find these commands on the Arrange menu, and from the menu accessed 
by right-clicking on a multiple selection.  

Combining items 

Combining merges selected items into a composite item, with a hole where filled 
regions overlap. The composite takes the line and fill of the bottom item. 
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1. Use the  Select tool to create a multiple selection containing the 
items to be combined. 
 

 

2. On the Arrange tab, click the  Combine button (you'll also find 
this option on the Arrange and right-click menus). 
 
The composite takes the line and fill of the back item. 
 

 

 To break apart the item, select it and click the button again. The top 
item will retain the line and fill of the back item.  

 You can also use the Crop Tool to crop photos and other items on 
your page. See Cropping your photos on p. 94. 
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Cropping items 

1. Use the  Select tool to create a multiple selection containing the 
items to be cropped. 

2. On the Arrange tab, click the  Crop button to display a flyout. 

3. To crop the bottom item to the outline of the top item, select Crop to 
Top Item.  
 

 
 
-or- 
 
To crop the top item to the outline of the bottom item, click Crop to 
Bottom Item.  
 

 

 To remove the crop, click Arrange>Crop then deselect Crop. 
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Clipping items 

1. Use the  Select tool to create a multiple selection containing the 
items to be clipped. 

2. On the Arrange tab, click the down arrow to expand the  Crop 
flyout. 

3. To clip the bottom item to the outline of the top item, click Clip to 
Top Item.  
 

 
 
-or- 
 
To clip the top item to the outline of the bottom item, click Clip to 
Bottom Item.  
 

 

 To remove the clip, click Arrange>Crop then deselect Crop. 
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Adding items 

Adding creates a new item that’s the sum of two or more selected items, 
whether or not they overlap. 
 

 

1. Use the  Select tool to create a multiple selection of items. (The 
items need not overlap.) 
 

 

2. On the Arrange tab, click  Add. 
 
The new item is a composite of the selected items, taking the line and 
fill of the bottom item. 
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Subtracting items 

Subtracting creates a new item, retaining only the portion of the bottom item 
that is not overlapped. This command is particularly useful for cutting out 
shapes from photos. 

  

1. Use the  Select tool to create a multiple selection of overlapping 
items. (The items must overlap.) 
 

 

2. On the Arrange tab, click  Subtract. 
 
The new item consists of the non-overlapping portion(s) of the 
bottom selected item. 
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Intersecting items 

Intersecting creates a new item by retaining the overlap and discarding the rest. 
 

 

1. Use the  Select tool to select two overlapping items. 
 

 

2. On the Arrange tab, click  Intersect. 
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The new item consists of the overlapping portions of the previously 
selected items, taking the line and fill of the back item. 

 Add, Subtract, and Intersect produce a permanent new item out of 
any selected items. You can only break the resulting item apart 
immediately after creating it by clicking the Undo button on the 
Standard toolbar. 

Erasing and adding to items 

    

Erasing Adding to 

CraftArtist provides the following tools for erasing and adding to existing lines 
and shapes: 

 Erase Tool 
Lets you erase portions of a selected item or items. You can control the extent of 
erasing by setting eraser tip width and pressure (if using a graphics tablet). 

 Freeform Paint Tool 
Lets you add to or ‘grow’ the boundary of an existing shape or line. This tool is 
especially useful for reshaping existing items, or for creating unusual filled 
shapes. 

 If you add to or erase from a bitmap, QuickShape, or artistic text 
item, the item will be converted to curves, preventing further 
editing in their original form. 
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Erasing portions of an item 

1. Use the  Select tool to select an item. 
 

  

 To erase selected items on multiple layers, ensure that the  Edit 
All Layers button, on the Layers tab, is selected. (See Working with 
layers in CraftArtist Help.) 

2. On the Standard toolbar, click the  Erase Tool. 

3. On the context toolbar, choose an eraser tip shape. 
 

  

4. Optional: Set the tip width by adjusting the Width value. 
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5. Position the  cursor, and drag over the item's edge. The area to be 
erased is drawn temporarily (use the Ctrl key to redefine the erase area 
while drawing). 
 

  

6. Release the mouse button to erase the area drawn. 
 

  

 The erasing process shows the background colour belonging to any 
item behind it (either on the same layer or a layer below the current 
layer). 
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Adding to an item 

1. Use the  Select tool to select an item. 
 

  

2. On the Standard toolbar, click the  Freeform Paint Tool. 

3. On the context toolbar, choose a shape for the tool's tip. 
 

  

4. Optional: 

• Set the tip width by adjusting the Width value. 

•  To create a series of shapes without switching tools, click to 
disable the Select-on-Create button. 
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5. Position the  cursor over the item and drag over an item boundary. 
 
You'll see shading, which represents the area to be added. 
 

  

6. Release the mouse button to reshape the item to include the painted 
area. 
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Using masks 
Masking is the process of hiding chosen areas of a layer to achieve dynamic 
visual effects—this can be easily done by using a mask layer. A mask layer hides 
the layer(s) underneath while any items placed on the mask layer are "cut away" 
to reveal what lies below. Mask layers are quick to add and simple to use and 
open up numerous creative possibilities. 
 

 

 
You can add a new mask layer from scratch and then add items to it, or you can 
convert an existing layer to a mask layer. 

By default, only the layer immediately beneath the layer mask is masked. If your 
project includes multiple layers and you wish to mask more than one layer, you 
can select which ones are masked. 

For more information on working with layers, see Working with layers on p. 53. 

To add a new mask layer: 

1. At the bottom of the Layers tab, click  Add Mask Layer. 
CraftArtist adds the new mask layer to the top of the layer stack; the 
layer immediately beneath it is entirely masked from view. 

2. Add items to the mask layer to cut away the mask, revealing the layer 
below. 
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To convert a layer to a mask layer: 

•  On the Layers tab, locate the layer you want to convert, and then 
click to enable its Mask icon. 
 
The layer is converted to a mask layer and the layer immediately 
beneath it is masked from view. 
 
Existing items on the mask layer (and new items you add) are cut 
away, revealing the layer below. 

 

 

 

  

  

 To turn a mask off, click the layer's  Mask icon again. 

 
To adjust the number of layers masked: 

1. On the Layers tab, right-click the mask layer and click Layer 
Properties. 

2. In the Layer Properties dialog, in the layers drop-down list, select the 
number of layers you want to mask.  
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Changing fill and line colour 
You can apply colours to the outline and interior of closed shapes and text items, 
and to lines and line segments. Digikit items, such as embellishments and 
materials, and photos can be recoloured.  

In the Digikit Browser, the Swatches category (shown when browsing items) 
offers a selection of colours specifically chosen to complement your installed 
Digikits. Once a Digikit is selected, these colours become available in the Digikit 
palette, which displays on the Colour tab. 

To apply fill and line colour, you can: 

• Select a swatch from the Digikit palette. (See below.) 

• Apply a colour tint or a transparent fill. (See Applying transparent fills 
on p. 199.) 

• Use the Colour tab's  Colour Picker to apply a colour used 
elsewhere on your page. (See Applying colours with the Colour Picker 
on p. 199.) 

• Use the Colour tab's Colour Wheel, Colour box, or sliders. (For more 
on the Colour tab, see CraftArtist Help.) 

• Mix a custom colour in the Colour Selector dialog. (See Using the 
Colour Selector dialog in CraftArtist Help.) 

• Apply a gradient fill. (See Applying gradient fills on p. 201.) 

• Apply a plasma or mesh fill. (See CraftArtist Help.) 

Applying colours from the Digikit palette 

1. Select a shape, line, or text item. 

2. On the Colour tab:  

•  To change line colour, click to select the Line swatch. 

•  To change fill colour, click to select the Fill swatch. 
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3. Click a palette swatch previously loaded from a Digikit (via Digikit 
Browser). The colour is applied and the Line/Fill swatch updates with 
the selected colour. 
 

  
 
For information on switching palettes, see Using colour palettes on 
p. 204. 

Applying colour tints 

1. Select a shape, line, or text item. 

2. On the Colour tab: 

• Click to select the Line or Fill swatch, as described in step 2 
above. 

• In the Colour Mode drop-down list, select Tinting. 

3. Drag the slider to the right to lighten the tint, or to the left to darken 
the tint. 
 

 

 You can also enter a percentage value in the box (0% resets to the 
original colour). 
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Applying transparent fills 

1. Select a shape, line, or text item. 

2. On the Colour tab, click to select the Line or Fill swatch, as described 
above. 

3. On the Colour tab, click the  No Fill swatch. 

 This applies transparency to items with line/fill properties, such as 
shapes and text. For pictures, clicking this swatch resets a 
recoloured picture back its original colours. See also Applying 
transparency on p. 156. 

Recolouring photos and Digikit items  

• Select the item, the click a palette swatch from the Colour tab. 

 For any black items (e.g., silhouette embellishments) you wish to 
colour, you'll have to first click Colour using HSL from the Photo 
context toolbar, then select a palette swatch as for coloured items. 

Applying colours with the Colour Picker 

Use the Colour Picker to sample (and then reuse) a colour from anywhere on 
your computer screen. The picked colour can then be made the current line or 
fill colour in CraftArtist. 

Various sampling methods can be used depending on the type of item fill or 
screen area to be sampled. 

To sample colours: 

1. On the Colour tab, click  Colour Picker. 

2. From the context toolbar, choose a colour picker type (e.g., Point 
Sampler). 
 

 

• Optional: If you use the Square or Circle Sampler, set a Colour 
Picker Size appropriate to the area you want to sample. 
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• Optional: Gradient Sampler offers a Gradient Picker Sensitivity 
option, for controlling the level of detail to which the gradient is 
sampled. 

3. Hold the mouse button down, and drag to the target area then release. 
 

 
 
-or- 
 
For gradient sampling: drag a line across your chosen colour 
gradient. 

The sampled colour(s) is picked up in the Colour tab's  Picked Colour 
swatch. 

To apply a sampled colour: 

1. Select a shape, line, or text item. 

2. On the Colour tab, click the  Picked Colour swatch to apply 
the colour. 



Working with colour 201 

 

Applying gradient fills 
Gradient fills include the Linear, Radial, Ellipse, Conical, Square, Three 
Colour, and Four Colour types. All of these apply colour ‘spectrums’ in a fill 
path spreading between two or more handles. Once you've applied a gradient 
fill, you can edit its fill path and change its colours. 

  

(A) Start Handle, (B) End Handle, (C) Fill Path - Linear 

Applying a gradient fill 

1. Select an item on your page. 

2. Click the  Fill Tool. 

3. Click and drag on the item to define the fill path. The item takes a 
simple Linear fill, grading from the current colour of the item, ending 
in white (items filled with white will grade from white to black, to 
show contrast). 
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 To constrain the fill path in 15° increments, hold down the Shift key 
while dragging. 

4. Optional: To change the fill style, choose from the drop-down list on 
the Fill context toolbar. 
 

 
 
The new fill path displays. Note that this will differ depending on the 
fill style selected. 
 

  

Editing a gradient fill path 

1. Select an item with a gradient fill applied. 

2. Click the  Fill Tool to display the fill path. 
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3. Move the fill path handles by clicking and dragging them. 
 

  
 
-or- 
 
Click and drag across the item to define a new fill path. 

 To constrain the fill path in 15° increments, hold down the Shift key 
while dragging. 

 For non-linear fills (e.g., radial, ellipse, etc.), to ensure that the origin 
of the gradient remains at the item's centre point, hold down the 
Ctrl key while dragging. 

Adding and deleting fill path handles 

1. Select an item with a gradient fill applied. 

2. Click the  Fill Tool to display the fill path. 

3. To add a handle, click anywhere on the fill path. 
 
-or- 
 
To delete a handle, click to select it and then press the Delete key. 

See also Editing gradient fills in CraftArtist Help. 
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Changing handle colours 

1. Select an item with a gradient fill applied. 

2. Click the  Fill Tool to display the fill path. 

3. Use any of the following methods to recolour fill path handles: 

• For a simple gradient fill with two handles, choose from the Fill 
Start and Fill End palettes on the context toolbar. 

• For fills with three or more handles, select a handle on the fill 
path, and then choose from the Fill Colour palette on the context 
toolbar. 

• Select a handle and then on the Colour tab, click a colour palette 
swatch or a colour from the HSL Colour wheel. See Editing 
gradient fills in CraftArtist Help. 

Using colour palettes 

  

When you apply a solid fill or line colour, you choose a 
colour belonging to a colour palette. 

Only one palette can be active at any one time. The 
currently active palette is displayed as a gallery of swatches 
on the Colour tab.  

You can add, edit, and remove palette colours, and switch 
between different palettes at any time. You can also create 
your own custom palettes from colour spreads and photos. 
(See Creating custom palettes in CraftArtist Help.) 

 Changes to palettes are saved globally and the 
new palette colours are automatically carried 
over to any new projects you create. 

The following palette types are available: 

• Digikit palette: These palette colours originate from your chosen 
Digikit—you'll see the Colour tab populate with Digikit colours when 
you select a Digikit for your new Craft project (see p. 206).  
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• Document palette: If you start a blank project from scratch, rather 
than from a Digikit, the default Document palette is displayed on the 
Colour tab. This palette provides a set of commonly-used colours from 
which to choose. 

• Standard RGB and Standard CMYK palettes: Palettes based on 
industry-standard colour models. 

• Themed palettes: CraftArtist also provides a range of designer-created 
themed palettes containing colours designed to work well together on 
the page. 

 When you save a project, its palette is saved along with it. 

Switching palettes 

1. On the Colour tab, click More. 

2. In the Colour Palette Designer, the Palettes drop-down list displays 
all of the palettes installed with CraftArtist. 
 

 

3. Select the palette you want to use. 

4. Click OK. 
 
The selected palette's colours appear as swatches in the Colour Palette 
Designer and on the Colour tab, replacing the swatches previously visible. 
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Adding swatches to the Digikit palette 

1. On the context toolbar, click  Add items from Digikits. 

2. In Digikit Browser, click the Browse my items tab. 

3. In the category list on the left, click Swatches. 

4. Swatches already added to your Digikit palette are highlighted in the 
main window. 
 

 

5. You can remove colours from the palette, and add colours from other 
installed Digikits. 

• To remove a colour from the palette, click to deselect it. 

• To add a colour, click to select it. 

6. Click Done. 
 
Colours are automatically removed from/added to the Digikit palette 
displayed on the Colour tab. 

Colours you apply to items from the Colour tab's HSL colour wheel (or 
equivalent) are automatically added to the Document palette. CraftArtist also 
lets you manually add colours to your Document palette, as well as edit, save, 
and load palettes. See CraftArtist Help. 
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Sharing on DaisyTrail 
You can share your project by print, via email, as a distributable electronic PDF, 
or via the DaisyTrail.com website. 

 

Publishing to DaisyTrail lets you contribute to the growing collection of 
published projects, and share your work with friends, family, and like-minded 
crafters! 

To share your projects via website, simply complete the following steps: 

• Register on the website. 

• Login with your DaisyTrail account information in CraftArtist. 

• Upload your chosen project. 

The DaisyTrail.com website is designed specifically as a digital crafting 
community. 

http://www.daisytrail.com/�
http://www.daisytrail.com/�
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Main website features include: 

• Free stuff 
DaisyTrail.com offers free Digikits for you to download which are 
often seasonal, based on events, or on occasions. 

• DaisyTrail shop 
Buy and download individual Digikits plus font collections, software, 
and other goodies. 

• Commend and comment! 
Praise and comment on other people's projects—and have your own 
designs assessed by the community. Click the like this button to 
commend your favourite projects. 

• Search 
Find projects, groups, or other users throughout the website. 

• Make new friends! 
Social networking meets craft designing! Use email or user discussion 
forums to build friendships with other crafters, especially those you 
add to your friends list. 

• Work in groups 
Create groups of users with similar interests—great for schools, clubs, 
or maybe just your network of "crafty" friends. 
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Registering 

1. On the Standard toolbar, click  Share. 

2. If you've not registered before, click the Join Now button. 

3. From the registration form, enter your personal information, 
including an email address to which an activation message will be sent. 

4. Click Create Account. To activate your account, you'll need to check 
your email and click on the activation message sent to you. This may 
take time depending on your ISP and connection. 

 Remember your Username and Password. You'll need to re-enter 
this information into CraftArtist. 

5. Registration is complete after activation. All you need to do now is to 
create your craft project and upload it! 

 If you don't add your DaisyTrail user account details, you'll be 
reminded to do so every eight days. You can register on the website, 
then transfer your username and password over, or cancel to enter 
your details later. 
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Uploading 

Once you've successfully created your account you can upload your project, with 
the option of including only specific or all pages. 

  

To share your project on DaisyTrail: 

1. On the Standard toolbar, click  Share. 

2. If you've registered (see above) and are uploading for the first time, 
enter the Username and Password you created on DaisyTrail. You 
won't need to do this again on subsequent uploads. 

3. In the dialog, uncheck pages you don't want to upload (use the scroll 
bar to view all pages). 

4. Optional: You can choose a different account to upload to. Click My 
Account and enter a different Username and Password. 

5. Click Upload to transfer your selected pages. 

6. On upload, a progress bar indicates upload status. 
 
On completion, click OK to close the dialog or click View to 
immediately see your uploaded project on the website. 

http://www.daisytrail.com/�
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Modifying account details in CraftArtist 

1. On the Tools menu, select Options. 

2. In the Upload pane, enter your Username and Password. 

3. Optional: Click the Test button to verify that the account details are 
correct. If successful, a "Username and password valid" message is 
displayed. 
 
If you've forgotten your password or you've not already registered, use 
the accompanying Reset Password and Register buttons. For the 
latter, you'll be directed to the Registration page on the website. 
Complete the registration details and click Create Account. 

4. Optional: Reduce the upload Quality to 96 DPI to speed up file 
transfer if your Internet connection is 56k dial-up modem (at the 
expense of zoom quality). 
 
Otherwise, use the default 300 DPI for broadband and all other faster 
Internet connections. 
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Interactive Print Preview 
The Print Preview mode changes the screen view to display your layout without 
frames, guides, rulers, and other screen items. Supporting toolbars allow for a 
comprehensive and interactive preview of your pages before printing. 

 

Print Preview is interactive because a main feature is to provide print-time 
imposition. Put simply, this allows you to create folded projects such as greeting 
cards, at the printing stage from unfolded basic page setups. Other interactive 
features are also available while in Print Preview. 

• Select installed printers, and choose which pages to print and how they 
print (to printer, file or separation). 

• Add and adjust printer margins. 

• Switch on/off page marks when generating professional output. 

Don't forget to make the most of Print Preview's powerful viewing controls 
hosted on the View toolbar. Use zoom controls, Pan/Zoom tools, and multi-page 
views for detailed preview work. 
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To preview the printed page: 

1. Select Print Preview from the File menu. In Print Preview, your first 
printer sheet is displayed according to your printer's setup. 

2. Optional: Choose an installed printer from the Printer toolbar. 

3. Optional: Adjust printer margins from the Margins toolbar if 
available. 

4. Review your project using the page navigation controls at the bottom 
of your workspace. 

To cancel Print Preview mode: 

• Select  Close Preview from the top of your workspace (  or 
click the window's Close button). 

Print-time imposition 

During print preview, you can enable imposition of your project, choosing a 
mode suited to your intended printed project. Each mode displays different 
toolbar options on the context-sensitive Imposition toolbar. 

 

To choose an imposition mode: 

• From the Imposition toolbar, select an option from the Imposition 
Mode drop-down list. 

For more information on individual imposition settings, please see the 
CraftArtist Help. 
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Printing cards and photobooks 

To produce double-sided sheets, click  Print and use the Print dialog's 
Double-sided Printing or Manual Duplex options (under More Options). Ensure 
your printer is setup for double-sided printing or run sheets through twice, 
printing first the front and then the back of the sheet (reverse top and bottom 
between runs). The sheets can then be collated and bound at their centre, with 
all the pages in the correct sequence. 

Printing 
CraftArtist supports printing directly to a physical desktop printer (e.g., All-in-
ones, Inkjet and Laser printers), with options for scaling and thumbnail printing. 

Greeting cards (below), scrap pages, and other projects can be printed quickly 
and easily. 
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Printing your project to a desktop printer is one of the more likely operations 
you'll be performing in CraftArtist. The easy-to-use Print dialog presents the 
most commonly used options to you, with a navigable "live" Preview window to 
check your print output. 

 

The dialog also supports additional printing options via the More Options 
button including Double-sided Printing, Manual Duplex, and many other 
useful printing options. One particular option, called Layout, allows for print-
time imposition of your document—simply create a booklet or other folded 
document at the print stage. 

Here we'll cover what you need to know for basic desktop printer output. If 
you're working with a professional printer and need to provide PDF output, see 
Exporting as PDF (p. 219). 

To set up your printer or begin printing:  

1. Click File>Print (or right-click on the page or pasteboard area and 
click Print). 

2. Select a currently installed printer from the Printer drop-down list. If 
necessary, click the Properties button to set up the printer for the 
correct page size, etc.  

3. Select a printer profile from the Profile drop-down list. You can use 
Current Settings, select from presets offering different print qualities, 
or choose a previously saved custom profile (.ppr) based on a 
combination of dialog settings; Browse... lets you navigate to any .ppr 
file on your computer. To save current settings, click the Save As... 
button, and provide a unique profile name. The profile is added to the 
drop-down list. 
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Note: If you modify a profile settings, an asterisk appears next to the 
profile name.  

4. Select the number of copies to print, and optionally select Collate to 
print the pages in ordered sets for each copy. Leave deselected to print 
all the copies of each page at once. 

5. Select the print Range to be printed, e.g. the Entire Project, Current 
Page, or range of pages. For specific pages or a range of pages, enter 
"1,3,5" or "2-5", or enter any combination of the two.  
 
To print selected text or items, make your selection first, then choose 
Current Selection appearing in the Range drop-down list after 
selection.  
 
Whichever option you've chosen, the Include drop-down list lets you 
export all sheets in the range, or just odd or even sheets, with the 
option of printing in Reverse order. 

6. Set a percentage Scale which will enlarge or shrink your print output 
(both page and contents) if Use Scale is selected. A 100% scale factor 
creates a full size print output. Alternatively, from the adjacent drop-
down list, choose Shrink to Fit to reduce your document's page size to 
the printer sheet size or Scale to Fit to enlarge or reduce the document 
page size as required. 

7. Keep Auto Rotate checked if you want your document page to 
automatically rotate your printer's currently set sheet orientation. 
When you access the Print dialog, if page and sheet sizes do not match, 
you'll be prompted to adjust your printer sheet orientation 
automatically (or you can just ignore auto-rotation). 

8. Click Print. 

 You may prefer to use the manual feed in any case if you're using 
thicker than usual print media such as card. 
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Exporting as PDF 
CraftArtist can output your drawings to PDF (Portable Document Format), a 
cross-platform WYSIWYG file format developed by Adobe, intended to handle 
documents in a device- and platform-independent manner.  

PDF documents are ideal for both screen-ready distribution and professional 
printing. In CraftArtist, ready-to-go PDF profiles are available for both uses, 
making PDF setup less complicated. 

• Screen-ready. If you require screen-ready PDFs you're likely to need 
PDF documents which are optimized for screen use, i.e. with 
downsampled images, document security, but without pre-press page 
marks, bleed, etc. Downsampling images leads to smaller documents 
for quicker loading. 
 
Profiles such as "Web - Compact" and "Web - Normal" are provided 
for screen-ready use (downsampling images to 96 and 150dpi, 
respectively), and are ideal for hosting PDFs on websites or other 
electronic distribution (email). 

• Professional. PDF documents are suited to professional printing, i.e. 
when you deliver a high quality reproduction of your drawing to a 
print partner (normally external to your company). You'll typically 
require page marks, bleed, ≥300dpi images, and PDF/X-1a 
compatibility (for CMYK output). 
 
To make things simple, the professional print profile called "PDF X-
1a" is provided in CraftArtist (using PDF X-1a compatibility), but you 
should check with your print partner if PDF/X-1, and any other 
settings, may be required instead. A "Press Ready" profile can also be 
used for documents which are not intended to be PDF/X compliant. 
 
With PDF/X-1a or PDF/X-1 compatibility, all your drawing's colours 
will be output in the CMYK colour space, and fonts you've used will be 
embedded. A single PDF/X file will contain all the necessary 
information (fonts, images, graphics, and text) your print partner 
requires. 
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To export your document as a PDF file (using a profile): 

1. From the File menu, select Export>Export as PDF. 

2. Select a profile for screen-ready or professional output (as described 
above) from the Publish profile drop-down list. 
 

 
 
The dialog updates with the selected profile's new settings.  

3. Optional: Make any custom settings as required by your print partner 
in each tab. 

4. Click OK. 

  

Sharing via email 
You can share your projects via email, attached as a JPEG or PDF, or as your 
original *.craft project. 

To share your project via email: 

1. On the File menu, click Send. 

2. In the Send dialog, choose the format in which to send your project. 
 
You can attach your project as a *.craft project file, as a JPEG image, or 
as a PDF document. 

3. Your project is attached to a new email message, which opens in your 
default email program. 

4. Just add your email recipient(s) and message and send your project! 
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Contacting Serif 

Contacting Support 

Our support mission is to provide fast, friendly technical advice and support 
from a team of experts. 

CraftArtist Support on the web 
Help www.serif.com/Support/ProductHelp/CraftArtist 

Community Forums www.daisytrail.com/forum.html 

 

www.youtube.com/serifvideos 

 Twitter @DaisyTrail 

 Facebook www.facebook.com/CraftArtist 

Submit a ticket support.serif.com 

 

http://www.serif.com/Support/ProductHelp/CraftArtist�
http://www.daisytrail.com/forum.html�
http://www.youtube.com/serifvideos�
http://twitter.com/%40DaisyTrail�
http://www.facebook.com/CraftArtist�


224 Additional information 

 

Additional CraftArtist information 

Main office (UK, Europe) 

Address The Software Centre, PO Box 2000 
Nottingham, NG11 7GW, UK 

Phone (0115) 914 2000 

Phone (Registration) (0800) 376 1989 
+44 800 376 1989 

Phone (Sales) (0800) 376 7070 
+44 800 376 7070 

Phone (Service and 
Support) 

0845 345 6770 

Fax (0115) 914 2020 

 

North American office (US, Canada) 

Phone (Registration) 800-794-6876 

Phone (Sales) 800-489-6703 

Phone (Customer 
Service) 

800-489-6720 

Support 603-886-6642 

 

For international enquiries, please contact our main office. 
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Credits 
This CraftArtist 2 Professional User Guide, and the software described in it, is 
furnished under an end user License Agreement, which is included with the 
product. The agreement specifies the permitted and prohibited uses. 

Trademarks 
Serif is a registered trademark of Serif (Europe) Ltd. 

CraftArtist is a registered trademark of Serif (Europe) Ltd. 

DaisyTrail is a registered trademark of Serif (Europe) Ltd. 

Microsoft, Windows, and the Windows logo are registered trademarks of Microsoft 
Corporation. All other trademarks acknowledged. 

Windows Vista and the Windows Vista Start button are trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or other countries. 

Adobe Flash is a registered trademark of Adobe Systems Incorporated in the 
United States and/or other countries. 

Copyrights 
Digital Images © 2008 Hemera Technologies Inc. All Rights Reserved. 

Digital Images © 2008 Jupiterimages Corporation, All Rights Reserved. 

Digital Images © 2008 Jupiterimages France SAS, All Rights Reserved. 

Bitstream Font content © 1981-2005 Bitstream Inc. All rights reserved. 

The Sentry Spelling-Checker Engine © 2000 Wintertree Software Inc. 

Panose Typeface Matching System © 1991, 1992, 1995-1997 Hewlett-Packard 
Corporation. 

FontForge © 2000,2001,2002,2003,2004,2005,2006,2007,2008 by George 
Williams. 

Portions of this software are copyright © 2008 The FreeType Project 
(www.freetype.org). All rights reserved. 

Anti-Grain Geometry - Version 2.4 © 2002-2005 Maxim Shemanarev (McSeem) 

TrueType font samples from Serif FontPacks © Serif (Europe) Ltd. 
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© 2012 Serif (Europe) Ltd. All rights reserved. No part of this User Guide may be 
reproduced in any form without the express written permission of Serif (Europe) 
Ltd. 

CraftArtist 2 Professional © 2012 Serif (Europe) Ltd. All rights reserved. 

Companies and names used in samples are fictitious. 
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2D filter effects, 150 
3D Decoupage Tool, 62 
3D filter effects, 153 
adjusting 

pictures, 97 
shapes, 170 

Adobe PDF files, 219 
artistic text, 125 
AutoFlow, 118 
Bézier curves, drawing, 172 
Break Apart, 182 
browsing 

Digikits, 29 
items, 30 

brush strokes 
adjusting offset of, 177 
applying, 83 
setting properties, 83 

Brush Tool, 83 
brushes, 79 

adding from Digikits, 81 
categories for, 79 
types of, 79 

Brushes tab, 79 
Clip to Bottom, 184 
Clip to Top, 184 
clipping items, 184 
closed lines (shapes), 173 
Colour Picker, 199 
Colour tab, 197, 204 

colours 
fill and line, 197 
palettes, 204 
tinting, 198 

combining items into new shapes, 
181 

copying (items), 77 
Crop to Bottom, 183 
Crop to Top, 183 
cropping, 183 

framed photos, 119 
items, 183 
photos, 94, 119 

curves 
drawing, 172 
editing, 174 
filling unclosed, 174 

Cutout Studio, 104 
cutting with Scissor Tool, 59 
DaisyTrail.com, 209 
decoupage effects, 62 
deleting pages, 48 
Digikits 

accessing, 29 
browsing, 29 
buying, 33 
creating, 36 
downloading, 34 
installing, 35 
saving, 38 

drop shadows, 147 
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edges 
on photos, 107 
on text, 137 

editing 
lines and shapes, 174 
shapes, 170 
text, 128, 131 

effects 
embossing, 150 
feathering, 150 
filters, 150, 153 
outline, 152 
textures, 155 

Erase Tool, 188 
exporting PDF files, 219 
features, new, 4 
fills 

gradient, 201 
transparent, 199 

filter effects, 150, 153 
Format Painter Tool, 177 
formatting text, 133 
frames (photo) 

adding, 113 
converting photos to, 122 
cropping, 119 
deleting, 121 
fitting photos to, 116 
rotating, zooming, panning, 120 

Freeform Paint Tool, 188 
gradient fills 

applying, 201 
editing, 202 

gradient transparency, 157 
Graphic Style Editor, 163 
graphic styles, 161 
HintLine toolbar, 50 
images (also photos), 87 
importing pictures, 87 
installation, 9 
installing Digikits, 35 
intersecting items, 187 
items 

adding to, 191 
adding to the workspace, 32 
browsing, 30 
clipping, 184 
combining into new shapes, 181 
creating custom, 36 
cropping, 183 
decoupaged, 62 
erasing, 189 
fills, 197 
intersecting, 187 
joining, 185 
line settings, 174 
on layers, 56 
punching, 73 
searching for, 30 
shapes, 169 
splitting, 59 
stamping, 77 
subtracting, 186 
tagging, 39 
transparency, 156 

joining items, 185 
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layers 
adding, 55 
deleting, 55 
locking, 55 
managing items on, 56 
masking, 193 
paper textures on, 155 
properties, 55 
renaming, 55 
selecting, 55 

Layers tab, 54 
letters, 23 
Line tab, 175 
lines 

adjusting offset of, 177 
closed (shapes), 173 
curved, 172 
drawing, 170 
editing, 174 
extending, 172 
filling unclosed, 174 
smoothing, 171 
straight, 171 
styles for, 175 
turning into shapes, 173 
weight of (width), 176 

Make & Do project, 25 
mask layers, 193 
new features, 4 
opacity (also transparency), 156 
outline effects 

adding to text, 137 
photos, 107 

Page Setup, 17 
page size, 16 
pages 

adding blank, 47 
adding pre-designed, 46 
copying, 49 
deleting, 48 
moving, 48 
navigating, 49 

Pages tab, 45 
palettes, colour 

selecting from, 197 
using, 204 

panning, 51 
paper textures, 155 
PDF files, exporting, 219 
Pen Tool, 172 
Pencil Tool, 171 
PhotoLab, 98 
photos 

adjusting, 91, 97 
converting to frames, 122 
cropping, 94, 119 
cutting out, 104 
deleting, 93, 121 
edge effects for, 107 
fitting to frames, 116 
importing, 87 
replacing, 91 
resizing, 93 
using AutoFlow, 118 

Print Preview, Interactive, 214 
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printing, 216 
imposition, 215 
preview, 214 
printer setup, 217 

projects 
blank, 16 
Make & Do, 25 
template-based, 13 

punches, 73 
Punches tab, 73 
QuickShapes 

adjusting, 170 
creating, 169 

registration, for project upload, 
211 

rule of thirds, on photos, 96 
saving Digikits, 38 
Scissor Tool, 59 
sentiments, 140 

adding, 141 
creating, 142 
editing, 142 

Shadow Tool, 147 
shadows (drop), 147 
shape text, 125 
shapes, 169 

combining, cropping, and 
joining, 181 

drawing, 169, 173 
editing, 170, 174 
using QuickShapes, 169 

Shapes Tool, 169 

sharing 
by email, 220 
by website, 209 

solid transparency, 157 
stamps, 77 
stencils, 68 
Stencils tab, 68 
straight lines, 171 
styles (graphic), 161 
subtracting items, 186 
support, 223 
system requirements, 8 
tab 

Brushes, 79 
Colour, 175, 197 
Layers, 54 
Line, 175 
Pages, 45 
Punches, 73 
Stencils, 68 

tagging, 39 
Digikits, 41 
items, 39 

technical support, 223 
templates, 13 
text 

artistic, 125 
combining, cropping, and 

joining, 181 
deleting, 132 
editing, 128, 131 
flow on a path, 135 
formatting, 130, 133 
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letters, 23, 126 
moving, 129 
outlines, 137 
resizing, 129 
rotating, 130 
selecting, 128 
shape, 125 

Text Tool, 125 
textures, paper, 155 
themes, choosing, 13 
tint, 198 
Tool 

3D Decoupage, 62 
Brush, 83 
Erase, 188 
Format Painter, 177 
Freeform Paint, 188 
Pen, 172 

Pencil, 171 
Scissor, 59 
Shadow, 147 
Shapes, 169 
Text, 125 
Transparency, 158 

toolbar, HintLine, 50 
transparency, 156 

composite, 160 
gradient, 157 
path, 159 
solid, 157 

Transparency Tool, 158 
transparent fills, 199 
uploading (projects), 212 
Welcome, 3 
zooming, 51 
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